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 SAFETY PRECAUTIONS  
(Please read these instructions before using this equipment.) 

 
Before using this product, please read this manual and the relevant manuals introduced in this manual 
carefully and pay full attention to safety to handle the product correctly. 
Refer to the Users manual of the CPU module to use for a description of the PLC system safety 
precautions. 
In this manual, the safety instructions are ranked as "DANGER" and "CAUTION". 
 
     

 DANGER 
 

Indicates that incorrect handling may cause hazardous 
conditions, resulting in death or severe injury. 
 

 

     

 CAUTION 
 

Indicates that incorrect handling may cause hazardous 
conditions, resulting in medium or slight personal injury or 
physical damage. 

 

     
 
Depending on circumstances, procedures indicated by  CAUTION may also be linked to serious 
results. 
In any case, it is important to follow the directions for usage. 

 

Please save this manual to make it accessible when required and always forward it to the end user. 
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For Safe Operations 
1. Prevention of electric shocks 

DANGER 
 Never open the front case or terminal covers while the power is ON or the unit is running, as this 
may lead to electric shocks. 

 Never run the unit with the front case or terminal cover removed. The high voltage terminal and 
charged sections will be exposed and may lead to electric shocks.  

 Never open the front case or terminal cover at times other than wiring work or periodic 
inspections even if the power is OFF. The insides of the module and servo amplifier are charged 
and may lead to electric shocks.  

 Completely turn off the externally supplied power used in the system before mounting or removing 
the module, performing wiring work, or inspections. Failing to do so may lead to electric shocks. 

 When performing wiring work or inspections, turn the power OFF, wait at least ten minutes, and 
then check the voltage with a tester, etc. Failing to do so may lead to electric shocks.  

 Be sure to ground the module, servo amplifier and servomotor (Ground resistance: 100  or 
less). Do not ground commonly with other devices. 

 The wiring work and inspections must be done by a qualified technician. 
 Wire the units after installing the module, servo amplifier and servomotor. Failing to do so may 
lead to electric shocks or damage. 

 Never operate the switches with wet hands, as this may lead to electric shocks. 
 Do not damage, apply excessive stress, place heavy things on or sandwich the cables, as this 
may lead to electric shocks. 

 Do not touch the module, servo amplifier, servomotor connector or terminal blocks while the 
power is ON, as this may lead to electric shocks.  

 Do not touch the built-in power supply, built-in grounding or signal wires of the module and servo 
amplifier, as this may lead to electric shocks. 

 
2. For fire prevention 

CAUTION 
 Install the module, servo amplifier, servomotor and regenerative resistor on incombustible. 
Installing them directly or close to combustibles will lead to fire. 

 If a fault occurs in the module or servo amplifier, shut the power OFF at the servo amplifier's 
power source. If a large current continues to flow, fire may occur.  

 When using a regenerative resistor, shut the power OFF with an error signal. The regenerative 
resistor may abnormally overheat due to a fault in the regenerative transistor, etc., and may lead 
to fire.  

 Always take heat measures such as flame proofing for the inside of the control panel where the 
servo amplifier or regenerative resistor is installed and for the wires used. Failing to do so may 
lead to fire.  

 Do not damage, apply excessive stress, place heavy things on or sandwich the cables, as this 
may lead to fire. 
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3. For injury prevention 
CAUTION 

 Do not apply a voltage other than that specified in the instruction manual on any terminal.  
Doing so may lead to destruction or damage.  

 Do not mistake the terminal connections, as this may lead to destruction or damage. 
 Do not mistake the polarity ( + / - ), as this may lead to destruction or damage. 
 Do not touch the heat radiating fins of module or servo amplifier, regenerative resistor and 
servomotor, etc., while the power is ON and for a short time after the power is turned OFF. In this 
timing, these parts become very hot and may lead to burns. 

 Always turn the power OFF before touching the servomotor shaft or coupled machines, as these 
parts may lead to injuries. 

 Do not go near the machine during test operations or during operations such as teaching. 
Doing so may lead to injuries.  

 
4. Various precautions 

Strictly observe the following precautions. Mistaken handling of the unit may lead to faults, 
injuries or electric shocks. 

(1) System structure 

CAUTION 
 Always install a leakage breaker on the module and servo amplifier power source. 
 If installation of an electromagnetic contactor for power shut off during an error, etc., is specified in 
the instruction manual for the servo amplifier, etc., always install the electromagnetic contactor. 
 Install the emergency stop circuit externally so that the operation can be stopped immediately and 
the power shut off. 
 Use the module, servo amplifier, servomotor and regenerative resistor with the correct 
combinations listed in the instruction manual. Other combinations may lead to fire or faults. 
 Use the CPU module and Simple Motion module with the correct combinations listed in the 
instruction manual. Other combinations may lead to faults. 
 If safety standards (ex., robot safety rules, etc.,) apply to the system using the module, servo 
amplifier and servomotor, make sure that the safety standards are satisfied. 
 Construct a safety circuit externally of the module or servo amplifier if the abnormal operation of 
the module or servo amplifier differ from the safety directive operation in the system. 
 In systems where coasting of the servomotor will be a problem during the forced stop, emergency 
stop, servo OFF or power supply OFF, use dynamic brakes.  
 Make sure that the system considers the coasting amount even when using dynamic brakes. 
 In systems where perpendicular shaft dropping may be a problem during the forced stop, 
emergency stop, servo OFF or power supply OFF, use both dynamic brakes and electromagnetic 
brakes.  

 The dynamic brakes must be used only on errors that cause the forced stop, emergency stop, or 
servo OFF. These brakes must not be used for normal braking. 

 The brakes (electromagnetic brakes) assembled into the servomotor are for holding applications, 
and must not be used for normal braking. 
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CAUTION 
 The system must have a mechanical allowance so that the machine itself can stop even if the 
stroke limits switch is passed through at the max. speed.  

 Use wires and cables that have a wire diameter, heat resistance and bending resistance 
compatible with the system.  
 Use wires and cables within the length of the range described in the instruction manual. 
 The ratings and characteristics of the parts (other than module, servo amplifier and servomotor) 
used in a system must be compatible with the module, servo amplifier and servomotor.  
 Install a cover on the shaft so that the rotary parts of the servomotor are not touched during 
operation.  
 There may be some cases where holding by the electromagnetic brakes is not possible due to the 
life or mechanical structure (when the ball screw and servomotor are connected with a timing belt, 
etc.). Install a stopping device to ensure safety on the machine side.  

 
(2) Parameter settings and programming 

CAUTION 
 Set the parameter values to those that are compatible with the module, servo amplifier, 
servomotor and regenerative resistor model and the system application. The protective functions 
may not function if the settings are incorrect.  

 The regenerative resistor model and capacity parameters must be set to values that conform to 
the operation mode and servo amplifier. The protective functions may not function if the settings 
are incorrect.  

 Set the mechanical brake output and dynamic brake output validity parameters to values that are 
compatible with the system application. The protective functions may not function if the settings 
are incorrect.  
 Set the stroke limit input validity parameter to a value that is compatible with the system 
application. The protective functions may not function if the setting is incorrect.  
 Set the servomotor encoder type (increment, absolute position type, etc.) parameter to a value 
that is compatible with the system application. The protective functions may not function if the 
setting is incorrect.  

 Set the servomotor capacity and type (standard, low-inertia, flat, etc.) parameter to values that 
are compatible with the system application. The protective functions may not function if the 
settings are incorrect.  
 Set the servo amplifier capacity and type parameters to values that are compatible with the 
system application. The protective functions may not function if the settings are incorrect. 

 Use the program commands for the program with the conditions specified in the instruction 
manual. 

 Set the sequence function program capacity setting, device capacity, latch validity range, I/O 
assignment setting, and validity of continuous operation during error detection to values that are 
compatible with the system application. The protective functions may not function if the settings 
are incorrect. 
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CAUTION 
 Some devices used in the program have fixed applications, so use these with the conditions 
specified in the instruction manual. 

 The input devices and data registers assigned to the link will hold the data previous to when 
communication is terminated by an error, etc. Thus, an error correspondence interlock program 
specified in the instruction manual must be used.  

 Use the interlock program specified in the intelligent function module's instruction manual for the 
program corresponding to the intelligent function module.  

 
(3) Transportation and installation 

CAUTION 
 Transport the product with the correct method according to the mass. 
 Use the servomotor suspension bolts only for the transportation of the servomotor. Do not 
transport the servomotor with machine installed on it.  

 Do not stack products past the limit.  
 When transporting the module or servo amplifier, never hold the connected wires or cables.  
 When transporting the servomotor, never hold the cables, shaft or detector. 
 When transporting the module or servo amplifier, never hold the front case as it may fall off. 
 When transporting, installing or removing the module or servo amplifier, never hold the edges.  
 Install the unit according to the instruction manual in a place where the mass can be withstood. 
 Do not get on or place heavy objects on the product. 
 Always observe the installation direction. 
 Keep the designated clearance between the module or servo amplifier and control panel inner 
surface or the module and servo amplifier, module or servo amplifier and other devices.  

 Do not install or operate modules, servo amplifiers or servomotors that are damaged or that have 
missing parts.  

 Do not block the intake/outtake ports of the servo amplifier and servomotor with cooling fan. 
 Do not allow conductive matter such as screw or cutting chips or combustible matter such as oil 
enter the module, servo amplifier or servomotor.  

 The module, servo amplifier and servomotor are precision machines, so do not drop or apply 
strong impacts on them. 

 Securely fix the module, servo amplifier and servomotor to the machine according to the 
instruction manual. If the fixing is insufficient, these may come off during operation. 

 Always install the servomotor with reduction gears in the designated direction. Failing to do so 
may lead to oil leaks. 
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CAUTION 
 

 Store and use the unit in the following environmental conditions. 

Conditions  
Environment 

Module/Servo amplifier Servomotor 

Ambient 
temperature 

According to each instruction manual. 
0°C to +40°C (With no freezing) 

(32°F to +104°F) 
 

Ambient humidity According to each instruction manual. 
80% RH or less 

(With no dew condensation) 
Storage 
temperature 

According to each instruction manual. 
-20°C to +65°C 
(-4°F to +149°F) 

 

Atmosphere 
Indoors (where not subject to direct sunlight). 

No corrosive gases, flammable gases, oil mist or dust must exist 
 

Altitude 1000m (3280.84ft.) or less above sea level  
Vibration According to each instruction manual  

 When coupling with the servomotor shaft end, do not apply impact such as by hitting with a 
hammer. Doing so may lead to detector damage. 
 Do not apply a load larger than the tolerable load onto the servomotor shaft. Doing so may lead 
to shaft breakage. 
 When not using the module for a long time, disconnect the power line from the module or servo 
amplifier. 
 Place the module and servo amplifier in static electricity preventing vinyl bags and store.  
 When storing for a long time, please contact with our sales representative.  
Also, execute a trial operation. 

 Make sure that the connectors for the servo amplifier and peripheral devices have been securely 
installed until a click is heard. 
Not doing so could lead to a poor connection, resulting in erroneous input and output. 

 
(4) Wiring 

CAUTION 
 Correctly and securely wire the wires. Reconfirm the connections for mistakes and the terminal 
screws for tightness after wiring. Failing to do so may lead to run away of the servomotor. 

 After wiring, install the protective covers such as the terminal covers to the original positions.  
 Do not install a phase advancing capacitor, surge absorber or radio noise filter (option FR-BIF) on 
the output side of the servo amplifier.  

 Correctly connect the output side (terminal U, V, W). Incorrect connections will lead the 
servomotor to operate abnormally. 

 Do not connect a commercial power supply to the servomotor, as this may lead to trouble. 
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CAUTION 
 Do not mistake the direction of the surge absorbing diode installed on the DC relay for the control 
signal output of brake signals, etc. Incorrect installation may lead to signals not being output 
when trouble occurs or the protective functions not functioning. 

 

RA
Control output
signal

DICOM

DOCOM

Servo amplifier
24VDC

Control output
signal

DICOM

DOCOM

Servo amplifier
24VDC

RA  
 

 Do not connect or disconnect the connection cables between each unit, the encoder cable or 
PLC expansion cable while the power is ON. 
 Securely tighten the cable connector fixing screws and fixing mechanisms. Insufficient fixing may 
lead to the cables combing off during operation. 
 Do not bundle the power line or cables. 
 Use applicable solderless terminals and tighten them with the specified torque. 
If any solderless spade terminal is used, it may be disconnected when the terminal screw comes 
loose, resulting in failure. 

 
(5) Trial operation and adjustment 

CAUTION 
 Confirm and adjust the program and each parameter before operation. Unpredictable 
movements may occur depending on the machine. 

 Extreme adjustments and changes may lead to unstable operation, so never make them. 
 When using the absolute position system function, on starting up, and when the module or 
absolute value motor has been replaced, always perform a home position return. 

 Before starting test operation, set the parameter speed limit value to the slowest value, and make 
sure that operation can be stopped immediately by the forced stop, etc. if a hazardous state 
occurs. 
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(6) Usage methods 

CAUTION 
 Immediately turn OFF the power if smoke, abnormal sounds or odors are emitted from the 
module, servo amplifier or servomotor. 

 Always execute a test operation before starting actual operations after the program or parameters 
have been changed or after maintenance and inspection. 
 Do not attempt to disassemble and repair the units excluding a qualified technician whom our 
company recognized. 
 Do not make any modifications to the unit. 
 Keep the effect or electromagnetic obstacles to a minimum by installing a noise filter or by using 
wire shields, etc. 
Electromagnetic obstacles may affect the electronic devices used near the module or servo 
amplifier. 
 When using the CE Mark-compliant equipment design, refer to the "EMC Installation Guidelines" 
(data number IB(NA)-67339) and refer to the corresponding EMC guideline information for the 
servo amplifiers and other equipment. 
 Note that when the reference axis speed is designated for interpolation operation, the speed of 
the partner axis (2nd axis, 3rd axis and 4th axis) may be larger than the set speed (larger than 
the speed limit value). 
 Use the units with the following conditions. 

 Conditions  
 

Item 
L61P L63P  

 Input power 100 to 240VAC
+10%
-15% 

(85 to 264VAC) 
24VDC

+30%
-35% 

(15.6 to 31.2VDC) 
 

 Input frequency 50/60Hz ±5%  

 
Tolerable momentary 
power failure 

10ms or less  
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(7) Corrective actions for errors 

CAUTION 
 If an error occurs in the self diagnosis of the module or servo amplifier, confirm the check details 
according to the instruction manual, and restore the operation. 

 If a dangerous state is predicted in case of a power failure or product failure, use a servomotor 
with electromagnetic brakes or install a brake mechanism externally. 
 Use a double circuit construction so that the electromagnetic brake operation circuit can be 
operated by emergency stop signals set externally. 

 

Servo motor
RA1 EMG

24VDC

Shut off with servo ON signal OFF,
alarm, electromagnetic brake signal.

Shut off with the
emergency stop
signal (EMG).

Electromagnetic
brakes

 
 

 If an error occurs, remove the cause, secure the safety and then resume operation after alarm 
release. 
 The unit may suddenly resume operation after a power failure is restored, so do not go near the 
machine. (Design the machine so that personal safety can be ensured even if the machine 
restarts suddenly.) 

 
(8) Maintenance, inspection and part replacement 

CAUTION 
 Perform the daily and periodic inspections according to the instruction manual.  
 Perform maintenance and inspection after backing up the program and parameters for the 
module and servo amplifier. 
 Do not place fingers or hands in the clearance when opening or closing any opening. 
 Periodically replace consumable parts such as batteries according to the instruction manual. 
 Do not touch the lead sections such as ICs or the connector contacts. 
 Before touching the module, always touch grounded metal, etc. to discharge static electricity from 
human body. Failure to do so may cause the module to fail or malfunction. 

 Do not directly touch the module's conductive parts and electronic components.  
Touching them could cause an operation failure or give damage to the module. 
 Do not place the module or servo amplifier on metal that may cause a power leakage or wood, 
plastic or vinyl that may cause static electricity buildup. 

 Do not perform a megger test (insulation resistance measurement) during inspection. 
 When replacing the module or servo amplifier, always set the new module settings correctly. 

 



 
 

A - 10 

 

CAUTION 
 When the module or absolute value motor has been replaced, carry out a home position return 
operation using one of the following methods, otherwise position displacement could occur. 

1) After writing the servo data to the Simple Motion module using programming software, switch 
on the power again, then perform a home position return operation. 

 After maintenance and inspections are completed, confirm that the position detection of the 
absolute position detector function is correct. 
 Do not drop or impact the battery installed to the module. 
Doing so may damage the battery, causing battery liquid to leak in the battery. Do not use the 
dropped or impacted battery, but dispose of it. 
 Do not short circuit, charge, overheat, incinerate or disassemble the batteries. 
 The electrolytic capacitor will generate gas during a fault, so do not place your face near the 
module or servo amplifier. 
 The electrolytic capacitor and fan will deteriorate. Periodically replace these to prevent secondary 
damage from faults. Replacements can be made by our sales representative. 
 Lock the control panel and prevent access to those who are not certified to handle or install 
electric equipment. 
 Do not mount/remove the module or terminal block more than 50 times (IEC61131-2-compliant), 
after the first use of the product. Failure to do so may cause malfunction. 
 Do not burn or break a module and servo amplifier. Doing so may cause a toxic gas. 

 
(9) About processing of waste 

When you discard module, servo amplifier, a battery (primary battery) and other option articles, 
please follow the law of each country (area).  

CAUTION 
 This product is not designed or manufactured to be used in equipment or systems in situations 
that can affect or endanger human life. 

 When considering this product for operation in special applications such as machinery or systems 
used in passenger transportation, medical, aerospace, atomic power, electric power, or 
submarine repeating applications, please contact your nearest Mitsubishi sales representative.  
 Although this product was manufactured under conditions of strict quality control, you are strongly 
advised to install safety devices to forestall serious accidents when it is used in facilities where a 
breakdown in the product is likely to cause a serious accident. 

 
(10) General cautions 

CAUTION 
 All drawings provided in the instruction manual show the state with the covers and safety 
partitions removed to explain detailed sections. When operating the product, always return the 
covers and partitions to the designated positions, and operate according to the instruction 
manual. 
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REVISIONS 
 The manual number is given on the bottom left of the back cover. 

Print Date  Manual Number Revision 
Jun., 2011 SH(NA)-030102-A First edition 

   

 
 

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent 
licenses.  Mitsubishi Electric Corporation cannot be held responsible for any problems involving industrial property 
rights which may occur as a result of using the contents noted in this manual. 

 
© 2011 MITSUBISHI ELECTRIC CORPORATION 
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INTRODUCTION 

Thank you for choosing the Simple Motion Module LD77MH. 
Before using the equipment, please read this manual carefully to develop full familiarity with the functions 
and performance of the Simple Motion Module you have purchased, so as to ensure correct use. 
 

CONTENTS 
 

Safety Precautions ..........................................................................................................................................A-  1 

Revisions .........................................................................................................................................................A-11 

Contents ..........................................................................................................................................................A-12 

1. OVERVIEW 1 

1.1 Features of Simple Motion Module (LD77MH) ..............................................................................................1 

1.2 Related Manuals .............................................................................................................................................1 

2. SIMPLE MOTION MODULE START-UP 2 to 39 

2.1 System which Combines LD77MH and MR-J3-□B........................................................................................3 

2.2 Preparing devices ...........................................................................................................................................4 

2.3 Startup procedures..........................................................................................................................................5 

2.4 Installing modules ...........................................................................................................................................6 

2.5 Wiring and connecting cables.........................................................................................................................7 

2.6 Installing application software.......................................................................................................................10 

2.7 Creating sequence programs by using GX Works2 ....................................................................................12 

2.8 Creating Parameter and Positioning Data by using Simple Motion Module Setting Tool ..........................19 

2.9 Operation Check ...........................................................................................................................................32 

3. SYNCHRONOUS CONTROL START-UP 40 to 57 

3.1 2-axes System where Synchronous Control is Available ............................................................................41 

3.2 Start-up Procedure in Synchronous Control ................................................................................................42 

3.3 Creating Parameter for Synchronous Control..............................................................................................43 

3.4 Operation check of synchronous control......................................................................................................51 

APPENDICES 58 to 75 

APPENDIX 1 Start address setting....................................................................................................................58 

APPENDIX 2 Parameter and positioning data..................................................................................................59 

APPENDIX 3 Various monitor functions............................................................................................................62 

APPENDIX 3.1 Axis monitor ...........................................................................................................................62  

APPENDIX 3.2 Error history of Simple Motion Module Setting Tool.............................................................68  

APPENDIX 3.3 PC diagnosis of GX Works2 .................................................................................................69  

APPENDIX 4 Sample program ..........................................................................................................................70 
 
 
 
 
 



 

 

 

1 

Quick Start Guide 

 
1. OVERVIEW 
This quick start guide describes the items and the operations which are needed to wire the Simple Motion 

Module, as well as to perform the JOG operation, the program operation and the simultaneous control by using 

the FA engineering software MELSOFT GX Works2 and MR Configurator2, for users who use the Simple 

Motion Module for the first time. To fully utilize each module, such as CPU modules of MELSEC-L series, 

please refer to the relevant manuals depending on the purpose. 

For users who use the MELSEC-L series CPU module (hereafter "CPU module") for the first time, please read 

"MELSEC-L Series Quick Start Guide" once. 

   
1.1 Features of Simple Motion Module (LD77MH) 

1) Wide range of controls is realized by high performance and multiple functions. 

This module realizes positioning control, synchronous control, cam control and speed and torque 

control. 

2) Adoption of the built-in synchronous encoder interface realizes cost reduction. 

3) Highly flexible baseless structure realizes space-saving control board. 

4) This module supports SSCNETIII and it can be connected with the high-performance servo amplifier. 

5) Simple control setting, without programs. 

6) Assistant function realizes easy setup. 

 Parameters can be setup, from settings to adjustment, by using "Simple Motion Module Setting Tool" 

which is installed in GX Works2 as standard equipment or MR Configurator2. 
 
1.2 Related Manuals 
(1) Simple Motion Module 

(2) MELSEC-L series programmable logic controller 

(3) Servo amplifier 

 

Name Manual Number
Type LD77MH Simple Motion Module User's Manual (Positioning control) 

This manual explains the functions of Simple Motion Module type LD77MH. 
In addition, it also describes the operations of devices and parameters, what is a basic knowledge 
necessary for programming. 

IB-0300172 

Type LD77MH Simple Motion Module User's Manual (Synchronous control) 
This manual explains the functions of Simple Motion Module type LD77MH. IB-0300174 

Name Manual Number

Programmable Controllers MELSEC-L Series Quick Start Guide 
This quick start guide introduces the basic installation procedures of programmable controllers. L08180E 

MELSEC-L CPU Module User's Manual (Hardware Design, Maintenance and Inspection) 
This manual explains the specifications and the methods for installation, maintenance and 
inspection of the CPU modules and power supply modules. 

SH-080890 

MELSEC-L CPU Module User's Manual (Function Explanation, Programmable Fundamentals) 
This manual explains the functions of CPU modules. 
In addition, it also describes devices and parameters, basic knowledge necessary for 
programming, as well as the operation of display units. 

SH-080889 

Name Manual Number
SSCNETIII Compatible MR-J3- B SERVO AMPLIFIER INSTRUCTION MANUAL 

This manual explains I/O signals, parts identification, parameters and startup procedures. SH-030051 

SSCNETIII Compatible Linear Servo MR-J3- B-RJ004U  INSTRUCTION MANUAL 
This manual explains I/O signals, parts identification, parameters and startup procedures. SH-030054 

SSCNETIII interface 2-axis AC Servo Amplifier MR-J3W-B SERVO AMPLIFIER INSTRUCTION 
MANUAL 

This manual explains I/O signals, parts identification, parameters and startup procedures. 
SH-030073 
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2. SIMPLE MOTION MODULE START-UP 
This document explains for the 1-axis system which applies a ball screw. 

 
<Device> 

 

 

 

 

 

 

 

 

 
<Specifications> 

Ball screw lead (PB) : 10000.0µm (=10mm) 

Reduction ratio (NL/NM) : 1/2 (Load side [NL]/Motor side [NM]) 

The ball screw on load side makes one rotation for each 2 revolutions of the 

motor. 

Encoder resolution : 262144PLS 

Servomotor : HF-KP series 

Servo amplifier : MR-J3-B series 

 
<Operation pattern> 

(1) Reciprocate between the home position (0mm) and P1. 

1) Move from the home position (0mm) to P1 at the speed of 2000.00mm/min. 

2) Move from P1 to the home position at the speed of 30000.00mm/min. 

(2) Execute the continuous positioning control to 1) and 2). 

 

<Position [mm]> 

P1=100.0mm 

 

 

P0=0.0mm 

 

 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 
PB 

2000.00 

<Speed [mm/min> 

-30000.00 

Time

Time
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2.1 System which Combines LD77MH and MR-J3-B 

The following shows the configuration example of a system which combines LD77MH4, MR-J3- B and a 
servomotor. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

Motor power  
supply cable 

MR-J3-B 

Servomotor 

SSCNET III 
cable 

Encoder 
cable 

No fuse 
breaker 
(NFB) 

Magnetic contactor 
(MC) 

～ 

CP

 

GX Works2 
MR Configurator2 

LD77MH4 L26CPU-BT

L61P 

USB cable 

Personal 
computer 
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2.2 Preparing devices 

Please prepare the following devices, cables and software. 

(1) Simple Motion Module 
Main unit 

Simple Motion Module 

LD77MH4  

LD77MH16 

(2) Servo amplifier, servomotor 
Servo amplifier 

MR-J3-B 

 

Servomotor 

 

(3) PLCs 
Power supply 

module 

L61P 

  

CPU 

module 

 

 

END cover 

L6EC 

 

Display unit 

L6DSP 

(Optional) 

 

DIN rail 
(JIS C 2812) 
• TH35-7.5Fe, • TH35-7.5Al 

• TH35-15Fe 

DIN rail stopper  

(4) Cables 
USB cable 

MR-J3USBCBL3M 

(USB A type – USB mini B type) 

 

Encoder cable 

 

 

Motor power supply 

cable 

 

SSCNET III Cable 

MR-J3BUS□ M 

 

(5) Software 
MELSOFT programming tool 

GX Works2 

SW1DNC-GXW2-E  

Version 1.48A or later 

Servo amplifier setup software 

MR Configurator2 

SW1DNC-MRC2-E  

Version 1.01B or later 
(6) Power distribution devices 

No fuse circuit breaker 

(NFB) 
Magnetic 

contactor 

(MC) 

Circuit protector 

(CP) 

  

 

 

L26CPU-BT 

or 

L02CPU 

(Included with 

CPU module) 
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2.3 Startup procedures 

This section describes the operations and steps of items needed for starting up the system. 

 

2.1 System which combines LD77MH 

and MR-J3- B. 
 

  

2.2 Preparing devices  

  

2.3 Startup procedures  

  

2.4 Installing modules (1) Installing modules 
(2) Installing batteries 
(3) Installing DIN rails 

  

2.5 Wiring and connecting cables (1) Wiring the power supply module 
(2) Wiring the power supply and the motor power to the servo 

amplifier 
(3) Setting the servo amplifier axis select rotary switch 
(4) Connecting various cables 
(5) Checking if the power is properly turned on 

  

2.6 Installing application software (1) Installing MELSOFT GX Works2 
(2) Installing MR Configurator2 
(3) Checking the startup of MELSOFT GX Works2 

  

2.7 Creating sequence programs  

by using GX Works2 

(1) Creating a new project 
(2) Creating sequence programs 
(3) Saving a sequence program as a project 
(4) Connecting CPU module and personal computer 
(5) Format of the CPU module 
(6) Writing the sequence program to the PLC CPU 

  

2.8 Creating parameter and positioning 

data by using Simple Motion Module 

Setting Tool 

(1) Adding a Simple Motion Module 
(2) Starting the Simple Motion Module Setting Tool 
(3) Creating a new project 
(4) Setting the system setting 
(5) Parameter setting 
(6) Servo parameter setting 
(7) Positioning data setting 
(8) Saving a Simple Motion Module as a project 
(9) Writing to the Simple Motion Module 

  

2.9 Operation check (1) JOG operation (for checking the rotation direction, the 
electronic gear setting etc.) 

(2) OPR (for checking a home position) 
(3) Positioning control 
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2.4 Installing modules 

Install the prepared modules. 

 

 

 

 

(1) Installing modules 
1) Release the module joint levers located on the top and bottom of the LD77MH module. 

(Slide the hook forward.) 

2) Engage the LD77MH module and the connector of the CPU module by plugging them properly. 

 

3) Lock the module joint levers located on the top and bottom of the LD77MH module. 

(Slide the hook backward.) 

4) Follow the same procedures of 1) to 3) to install the END cover. 

 

5) Completed 

 

(2) Installing batteries 
Connect a battery connector when using the CPU module for the first time. 

 

 

 

(3) Installing DIN rails 
Install the module to DIN rails. 
 
 

 

(4) Installation completed 

1)
3)

4) 2)
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2.5 Wiring and connecting cables 

The following shows the connection examples of wiring and connecting cables of the Simple Motion 

Module (LD77MH) and the servo amplifier (MR-J3 series). Use cables with the same wire size as when the 

servo amplifier, MR-J3-10B, is used. In case that the capacity of the servo amplifier is different, refer to the 

servo amplifier instruction manuals. 

 

(1) Wiring the power supply module 
The following shows an example of wiring the power supply wires and grounding wire tor power supply 
module. Connect an isolation transformer when much noise is generated in the power supply system. 

Item Applicable wire size Tightening torque 

Power supply wires 0.75 to 2mm2 (AWG18 to AWG14) 0.59 to 0.88N•m 

Grounding wire 0.75 to 2mm2 (AWG18 to AWG14) 0.59 to 0.88N•m 

 

 

 

  
 
 
 
 
 
 

(2) Wiring the power supply and the motor power to the servo amplifier 
Wire the control circuit power (L11, L21), main circuit power (L1, L2 and L3) and motor power line (U, V 
and W) to the servo 
amplifier. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 

 

Item 
Applicable wire 

size 

Tightening 

torque 

Control circuit power (L11, L21) 1.25mm2 (AWG16) - 

Main circuit power (L1, L2, L3)    2mm2 (AWG14) - 

Motor power line (U, V, W) 1.25mm2 (AWG16) - 

Grounding wire 1.25mm2 (AWG16) 1.2N•m 

 

 

～ 

CP 

Grounding 
To the following figure 1) 

AWG14 

CP: Abbreviation for Circuit Protector 

 

 

1) 

L1 
L2 

 

L3 

L11 

 

L21 

Grounding 

AWG16 

AWG16 

AWG14 

AWG16 

Next page 
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(3) Setting the servo amplifier axis select rotary switch 
The switches "0" to "F" of servo amplifier axis select rotary switch correspond to d01 to d16. 
The relationship between "SSCNET Structure" and axis select rotary switch is shown in the figure below. 
Set the switches to the corresponding axis No. 

 

MR-J3- B 
Axis select 

rotary switch 
Description 

Cover is 

opened 

 

 

 

 

Axis select 

rotary switch
dno. Axis No

Axis select 

rotary switch 
dno. Axis No

"0" d01 Axis 1 "8" d09 Axis 9

"1" d02 Axis 2 "9" d10 Axis 10

"2" d03 Axis 3 "A" d11 Axis11

"3" d04 Axis 4 "B" d12 Axis 12

"4" d05 Axis 5 "C" d13 Axis 13

"5" d06 Axis 6 "D" d14 Axis 14

"6" d07 Axis 7 "E" d15 Axis15

"7" d08 Axis 8 "F" d16 Axis16

LD77MH4 can set up to axis 4, and LD77MH16 can set up to axis 16. 

 

Servo 

amplifier 

 

Refer to Section 2.8 for details of system setting.  
 

   

(4) Connecting various cables 
Connect the SSCNETIII cable and the encoder cable. Connect the USB cable between personal 
computer and PLC CPU. (Refer to Section 2.1) 

Next page 
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(5) Checking if the power is properly turned on 
Make sure that the power supply of PLC and servo amplifier is properly turned on. 

1) Check the wiring of the PLC CPU module. 

2) Turn on the power supply of the PLC. 

                 (a)          (b) 

(a) Power supply module: LED (Green) is lit. 

(b) CPU module: MODE LED (Green) is lit. 

 When parameters and programs are not written to the CPU module, there is no problem with 

flashing of ERR LED in red. ERR LED is turned off when the power supply is turned off and then on 

after writing parameters and programs. 

3) Check the wiring of the servo amplifier. 

4) Turn on the power supply of the servo amplifier. 

The communication status with LD77MH can be checked in the servo amplifier display. 

Servo amplifier 
LED 

display 
Status Description Wiring result

AA 
Initializing 

standby 

The power supply of the LD77MH is 

turned off. 

Ab Initializing 

The power supply of the servo amplifier 

is turned on while the power supply of 

the LD77MH is turned off. 

b01 Ready OFF 
PLC ready signals of LD77MH are 

received. 

C01 Servo OFF Servo off command is received. 

d01 Servo ON 
All axes servo on signal of LD77MH 

received. 

E6 
During servo 

forced stop 

During servo forced stop of the servo 

amplifier 

E7 
During controller 

force stop 
During force stop of LD77MH 

Normal 

 

Off - The control power supply is turned off. Error 

<Countermeasures> 

1) The LED display of the servo amplifier is AA or Ab when parameters are not written to LD77MH, 

but there is no problem. Write parameters to LD77MH. 

2) Check the wiring of the control power supply when LED is turned off. 

(6) Completed 
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2.6 Installing application software 
 

The following shows how to install MELSOFT GX Works2 as a programming tool, and MR Configurator2 as 

a servo parameter setting tool. 
 
(1) Installing MELSOFT GX Works2 

Install the software by following the instruction manual which comes with MELSOFT GX Works2. 

Item Model name Overview 
Supported 

version 

MELSOFT  

GX Works2 
SW1DNC-GXW2-E 

1) Mitsubishi IQ Platform-compatible 

Programmable Controller Engineering 

Software 

(Integrated software of programming, 

simulation, module settings and monitoring tool 

function) 

1.48A 

 

 

 

MELSOFT
GX Works2

(2) Installing MR Configurator2 
Please contact your nearest Mitsubishi sales representative for the MR Configurator2. 

 

Item Model name Overview 
Supported 

version 

MR Configurator2 SW1DNC-MRC2-E 
1) Parameter settings and adjustment of servo 

amplifier 

(Parameter settings, monitoring and graphs) 

1.01B or 

later 

 Next page 
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(3) Checking the startup of MELSOFT GX Works2 

1) Creating an icon of MELSOFT GX Works2. 

Select [Start] → [All Programs] → [MELSOFT Application] → [GX Works2] → [GX Works2]. 

 

 

 

 

 

And then, the icon can be created on desktop by right-clicking to select [Send To] →  

[Desktop (Create Shortcut)]. 

 

 

2) Starting MELSOFT GX Works2 

• When there is an icon 

Double-click to start MELSOFT GX Works2 

 

• When there is no icon 

Click [Start] → [All Programs] → [MELSOFT Application] → [GX Works2] → [GX Works2] to start the 

software. 

The main screen of GX Works2 will appear. 

 

(4) Completed 
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2.7 Creating sequence programs by using GX Works2 

This section explains the methods from creating to saving a new project of the sequence program.  

 

(1) Creating a new project 
1) Starting MELSOFT GX Works2 

Double-click  to start MELSOFT GX Works2 

 
 

2) Creating a new project 

A project contains programs, device comments and parameters. 

 

Project Type : Simple Project 

PLC Series : LCPU 

PLC Type : L26-BT (This section explains the method with an example of using 

L26CPU-BT.) 

Programming Language : Ladder 

Use Label : Not Use 

 

3) Displaying the main screen 
Click the OK button to display a project tree and circuit screen on the main screen. 

 

 

 

 

 

 

 

 

 

 
 

4) New project creation completed 
 

2) 

3) 
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(2) Creating sequence programs 
For the next step, create a sequence program. 
For the details, refer to the related manuals written in "1.2 Related manuals (2) MELSEC-L series 
programmable logic controller". 
In addition, if you wish to use sample data, please contact your nearest Mitsubishi sales representative.  
 

1) Sample data 

 

[Sample data of LD77MH] 

Item Project name Description 

L02_LD77MH4_SEQ for L02CPU and LD77MH4 (Axis 4 type) 

L26_LD77MH4_SEQ for L26CPU and LD77MH4 (Axis 4 type) 

L02_LD77MH16_SEQ for L02CPU and LD77MH16 (Axis 16 type) 
LD77MH sample data 

L26_LD77MH16_SEQ for L26CPU and LD77MH16 (Axis 16 type) 

 

2) Unpacking the LD77MH sample data 

Unpack the LD77MH sample data into any folder. 

 

Item Packed data 

LD77MH sample data ld77mhe_00c 

 

 

3) Reading sequence programs 

Projects of the sequence program are read from the unpacked sample data. 

(a) Select [Project] → [Open Project] from the menu. 

(b) Click the [Browse] button to select the folder in which the project is saved. 

(c) Select the project. 

 

 

 

(a) 

(b) 

(c) 

3) 

Next page 
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4) Displaying the main screen 

Click the [Open] button to display the main screen. 

 

5) Sequence program completed 
 
(3) Saving a sequence program as a project 

1) Select [Project] → [Save As] from the menu. 

2) Select [Browse] to specify the save destination path. 

3) Enter any names (for workspace, project and title). 

Make sure not to overwrite to the original project. 

4) Click the [Save] button.  

5) To save the project, click the [Yes] button. 

 

  

6) Saving projects completed  

 

1) 

2) 

3) 

4) 

5) 
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(4) Connecting CPU module and personal computer 
Write sequence programs to PLC CPU. 

 

1) Connecting CPU module and personal computer 

 

 

 
 

2) PLC power supply ON 

Turn on the power of the power supply module. 

3) Connection settings of GX Works2 and PLC 

Click the [Connection Destination] and double-click the [Connection 1] button. 

 

 

 

 

Double-click [Serial USB] on PC side I/F to display the screen 
shown left. 
 

Select "USB". 

 

Double-click [CPU Module] on PLC side I/F to display the screen 
shown left. 

 

Select "LCPU". 

 

Select "No Specification" in specification of Other Stations Setting. 

 Press the button of the connection test. 
When the procedure is completed without error, the connection 
completion screen will appear. 

4) Connecting CPU module and personal computer completed 
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(5) Format of the CPU module 
 

1) Format of the CPU module 

Select [Online] → [PLC Memory Operation] → [PLC Memory Format] from the menu. 

 

  

Select [Program memory/Device 

memory] from the target memory. 

2) Click the [Execute] button to display the memory format confirmation screen. 
 

 

 

 

 

 

 

 

3) Memory format completed 
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(6) Writing the sequence program to the PLC CPU 
Open the front side cover of CPU module, and place the switch to the position of STOP. Then, write 
data to CPU. 

 

1) Writing to CPU module 

Click [Parameter + Program], and also click [Execute] to write to the PLC CPU. 

 

 

 

2) Transference to CPU module 

Click [Close] to close the window after writing is completed. 

 

 

Next page 
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3) Termination of writing to CPU 

 

 

 

 

 

    

 

 

 
 
 

 

Click [Close] to close the window. 

 

 

 

4) Writing to CPU module completed 
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2.8 Creating Parameter and Positioning Data  

by using Simple Motion Module Setting Tool 
 

This section explains the setting methods of parameters and positioning data used in the Simple Motion 

Module (LD77MH). 
 

(1) Adding a Simple Motion Module 
1) Right-click on [Intelligent Function Module] in GX Works2 to select [New Module]. 

 

 

2) Select a module. 
The following shows a setting example of when the Simple Motion Module (LD77MH) is connected next 
to the CPU module. 

PLC type 
Item 

L02CPU L26CPU-BT

Module Type Simple Motion Module 

Module Name LD77MH4 

Mounted Slot No. 0 

Specify start XY 

address 
0010 0030 

Specify start XY address  (Click the checkbox.)

Title Optional 

 

3) Click the [OK] button. 

 

Point  
 

The start address of the Simple Motion Module (LD77MH) differs depending on the combination 

with CPU module. For details, refer to Appendix 1. 

 

4) Setting completed 

1) 

2) 

3) 
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The following explains the setting method with the Simple Motion Module Setting Tool. 

(2) Starting the Simple Motion Module Setting Tool 
1) Double-click the [Simple Motion Module] button to start the Simple Motion Module Setting Tool. 

  

 

(3) Creating a new project 
1) Click the [New] button. 

PLC type Item 

L02CPU L26CPU-BT 

Module type Simple Motion Module 
Module name LD77MH4 

Specify start XY address 0010 0030 
Title Optional 

 

Module type:  

Simple Motion Module 

Module name  : LD77MH4 

Specify start XY address : 0030 

  

 

2) Click the [OK] button to add LD77MH to the intelligent function module of the project. 

 

3) Continue to (4) Setting the system setting. 

1) 

3) 

(3) 
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(4) Setting the system setting 

Set the necessary parameters for the Simple Motion Module (LD77MH) in series. 

 

1) Double-click the [Intelligent Function Module] → [System Structure] buttons. 

2) Double-click the image of the first axis of the servo amplifier. 

 

 

 

 

 

 

3) Select MR-J3(W)-B and click the [OK] button to display the servo amplifier. 

 

 

 

4) System configuration setting completed 
 

1) 

2) 

3) 
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(5) Parameter setting 
 

1) Double-click the [Intelligent Function Module] → [Parameter] buttons. 

 

 

2) Basic parameter setting 
Click the [Compute Basic Parameter 1 (B)] button. 

3) Enter a numerical value according to the specification of the device. 

<Device specifications> 

Machine Components : Ball Screw, Horizontal  

Unit setting  : 0mm 

Lead of Ball Screw : 10000.0 [μm] 

Reduction ratio (NL/NM) : 1/2 (Load side [NL]/Motor side [NM]) Motor side makes two rotations while 

  the load side makes one. 

Encoder Resolution : 262144 [PLS/rev] 

4) Click the [Compute Basic Parameters 1] button. 

 

5) The calculation result is reflected to the parameter by clicking the [OK] button. 

 

 

 

1) 

2)

3) 

4) 

5)

Next page 
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6) Set other parameters. 
Change the underlined part. (There is no need to change the basic parameter 1 since the parameter is 
already set in the previous section.) 
The value can be changed by double-clicking each item of the parameter setting screen. 

 

Point  
 

(a) The default values of the input signal logic selection upper limit and lower limit are set to 
negative logic, considering the safety. If you do not use these signals, change the values 
to positive logic before use. 

(b) Forced stop input signal is enabled, considering the safety. If users do not use this signal, 
switch it to be disabled before using. 

 
Item Description 

Unit setting 0: mm 
Number of pulses per revolution 16384 [PLS] (262144 [PLS]) 
Movement amount per revolution 312.5 [μm] (5000.0 [μm]) 
Unit magnification 1: × 1 time 

Basic 
parameters 1 

Bias speed at start 0.00 mm/min 
Speed limit value 30000.00 [mm/min] 
Acceleration time 0 1000 [ms] 

Basic 
parameters 2 

Deceleration time 0 1000 [ms] 
Backlash compensation amount 0.0 [µm] 
Software stroke limit upper limit value 214748364.7 [µm] 
Software stroke limit lower limit value -214748364.8 [µm] 

Software stroke limit selection 
0: Apply Software Limit to Current Feed 

Value 
Software stroke limit valid/invalid setting 0: Valid 
Command in-position width 10.0 [µm] 
Torque limit setting value 300 [%] 
M code ON signal output timing 0: WITH mode 
Speed switching mode 0: Standard Speed Switching Mode 
Interpolation speed designation method 0: Composite Speed 
Current feed value during speed control 0: Not update of current feed value 
Input signal logic selection : lower limit 1: Positive Logic 
Input signal logic selection : upper limit 1: Positive Logic 
Input signal logic selection : Stop signal 0: Negative Logic 
Input signal logic selection: External command/ 
switching signal 

0: Negative Logic 

Input signal logic selection: Near-point dog signal 0: Negative Logic 
Input signal logic selection: Manual pulse generator 
input 

0: Negative Logic 

External Input signal selection 1: Use Input of Servo Amplifier 
Manual pulse generator/ Incremental synchronous 
encoder input selection 

0: A-phase/B-phase mode (4 multiply) 

Speed-position function selection 
0: Speed-Position Switching Control 

(INC Mode) 

Detailed 
parameters 1 

Forced stop valid/invalid selection 1: Invalid 
Acceleration time 1 1000 [ms] 
Acceleration time 2 1000 [ms] 
Acceleration time 3 1000 [ms] 
Deceleration time 1 1000 [ms] 
Deceleration time 2 1000 [ms] 

Detailed 
parameters 2 

Deceleration time 3 1000 [ms] 

 Next page 
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Item Description 
JOG speed limit value 15000.00 [mm/min] 
JOG operation acceleration time selection 0: 1000 
JOG operation deceleration time selection 0: 1000 

Acceleration/deceleration process selection 
0: Trapezoidal acceleration/ 

deceleration processing 
S-curve ratio 100 [%] 
Sudden stop deceleration time 1000 [ms] 
Stop group 1 sudden stop selection 0: Normal deceleration stop 
Stop group 2 sudden stop selection 0: Normal deceleration stop 
Stop group 3 sudden stop selection 0: Normal deceleration stop 
Positioning complete signal output time 300 
Allowable circular interpolation error width 10.0 [µm] 
External command function selection 0: External positioning start 
Speed control 10 x multiplier setting for degree axis 0: Invalid 
Restart allowable range when servo OFF to ON 0 [PLS] 
Manual pulse generator/ Incremental synchronous 
encoder input type selection 

0: Differential output type 

Operation setting for speed-torque control mode: 
Speed initial value selection 

0: Command speed 

Operation setting for speed-torque control mode: 
Condition selection at  mode switching  

0:Switching Conditions Valid at 
Switching Mode 

Detailed 

parameters 2 

External command signal selection 0:Unused 
OPR method 6: Data set method 

OPR direction 
0: Positive direction (address 

increment direction) 
OP address 0.0 [μm] 
OPR speed 0.01 [mm/min] 
Creep speed 0.01 [mm/min] 

OPR 

(Original Point 

Return) basic 

parameters 
OPR retry 0: Do not retry OPR with limit switch 
Setting for the movement amount after near-point dog ON 0.0 [µm] 
OPR acceleration time selection 0: 1000 
OPR deceleration time selection 0: 1000 
OP shift amount 0.0 [µm] 
OPR torque limit value 300 [%] 
Operation setting of incompletion of OPR 0: Positioning control is not executed. 
Speed designation during OP shift 0: OPR speed 
Dwell time during OPR retry 0 [ms] 
Pulse conversion module : OPR request setting 0: Turn OPR Request ON at Servo OFF

OPR  

(Original Point 

Return) detailed 

parameters 

Pulse conversion module :Waiting time after clear 
signal output 

100 ms 

Optional data monitor : Data type setting 1 0: No Setting 
Optional data monitor : Data type setting 2 0: No Setting 
Optional data monitor : Data type setting 3 0: No Setting 
Optional data monitor : Data type setting 4 0: No Setting 

Expansion 

parameters 

Operation cycle setting 1: 1.77 ms 

Note 1 : The Operation cycle setting and External command signal selection are used only in a 

parameter of LD77MH16. 
<Example of setting the speed limit value in maximum motor speed> 

Ball screw lead : 10.0 [mm] 
Servomotor : HF-KP13 (262144 [pulse/rev]) 
Gear  : 1/2 

 
Speed limit value = Maximum motor selection [r/min] × Gear ratio (n) × Ball screw lead [mm] 

= 6000 [r/min] × 1/2 × 10 [mm] 
= 30000.00 [mm/min] 

 

 
7) Parameter setting completed 
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(6) Servo parameter setting 
 

1) Start MR Configurator2. 
Click the [Servo Parameter Setting] button to start MR Configurator2. 

  

2) Invalidity of forced stop signal 
Select "Invalid (Not use forced stop input (EMI))" in the servo forced stop selection. 

 

 

Point  
 

Forced stop input selection specifies whether to load or not the forced stop input signal from 
the servo amplifier. For safety reasons, the default setting is "Select Forced Stop Input 
Selection (EM1)". For not loading the forced input signal, change to setting to "Not Select 
Forced Stop Input Selection (EMI)". 

 
3) Home position set condition selection 

Click [Component parts] to display the component parts screen. 
Select "Z-phase must not be passed." in the home position set condition selection. 

  

 

Point  
 

If selecting "Z-phase must not be passed.", it is possible to carried out the home position 
return (OPR) even though a motor has not turned 1 or more revolutions for home position 
return. 

4) Close MR Configurator2. 
Click the [] button to display the save confirmation screen of the changed contents. 
Click the [Yes] button to close MR Configurator2. 

5) Servo parameter setting completed 

1) 

2)

4) 
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(7) Positioning data setting 
This section explains the setting method of the positioning data with using program examples which 

reciprocate between the home position and P1. 

[Operation example of returning the original position after moving to P1] 

 

  

 

 

 

 
 
 
 
 
 

1) Selecting the positioning data 
Double-click [Positioning Data Axis 1] to display the positioning data screen. 

 

 
2) Selecting the data setting assistant 

Click the [Data Setting Assistant] button to display the screen as follows. 

3) Input data for each item and the positioning control system. 

Positioning control selection 

 ……………1-axis linear control (ABS)

Positioning Data No. …..…1 

Positioning Address (Reference axis): 

100000.0 [µm] 

Command Speed.…2000.00 [mm/min]

Operation Pattern….1: Continuation 

Acceleration Time No. ……0: 1000 

Deceleration Time No. ……0: 1000 

Dwell Time……………….…0: 0 [ms] 

M code…………………..…0 

 

 

1) 

2) 

3) 

4) 

Next page 

2000.00 
<Speed [mm/min> 

-30000.00 

P1=100.0mm 

P0=0.0mm 

<Position [mm/min]> 

Time 

Time 
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4) Click the [Set] button to close the data setting assistant screen and display the positioning data screen. 

 

 
5) Create the command which returns from P1 to the home position in the positioning data No.2 by using 

the same method. 

No. 
Operation 

pattern 
Control 
system

Axis to be 
interpo- 

lated 

Acceleration 
time No. 

Deceleration 
time No. 

Positioning 
address 

Arc 
address 

Command 
speed 

Dwell 
time

M 
code

1 
1: 

Continuation 

ABS 

linear 1 – 1:1000 1:1000 100000.0μm
0.0 

μm 

2000.00 

mm/min 0ms 0 

2 
0: 

Completion 

ABS 

linear 1 – 1:1000 1:1000 
0.0 

μm 

0.0 

μm 

30000.00 

mm/min 0ms 0 

 

6) Positioning data completed 
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(8) Saving a Simple Motion Module as a project 

Save a project of the Simple Motion Module. 

<Save data> 
Item Description Remark 

System Structure Existence of axes, amplifiers and virtual servo to be used 
Parameter Overall parameter of each axis 
Servo parameter Parameter of servo amplifier 
Positioning data Positioning data 

Always 
necessary

Block start data Data for block start 
Synchronous control parameter Parameter for synchronous control 
Cam data Cam pattern 

If needed

 

1) Select [Project] → [Save As] from the menu. 

2) Select [Browse] to specify the save destination path. 

3) Enter any names (for workspace, project and title). 

 

 

 

4) Click the [Save] button. 
When the new project is saved, the save confirmation screen appears. 

 

5) Saving the project of the Simple Motion Module completed 
 

 

1) 

2) 

3) 

4) 
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(9) Writing to the Simple Motion Module 

Write parameters and positioning data to the Simple Motion Module. 
 

1) Change the [RESET/RUN/STOP] switch of the PLC CPU module to STOP. 

 

 

2) Writing to LD77MH 
Select [Online] → [Write to Module ] to display the screen to write to LD77MH. 
After setting [Select All], press the [Execute] button to display the write to module screen. 

 

 
3) Writing flash ROM 

Press the [Yes] button to write data to the flash ROM of the Simple Motion Module. 

 

 

 
Point  

 
 If the data is not written to the flash ROM, the data is erased by turning the power supply 

OFF to ON. 

Next page 
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4) Power OFF to ON 

Reset the PLC CPU or power OFF to ON. 
If the servo parameter is overwritten, power the servo amplifier OFF to ON. 

 

Point  
 

Please write the sequence program, the parameters and the other data of the simple motion 

controller at first. And switch power off once and then switch it on again. When “ERR. LED”

lights up or blinks please confirm the error and take measures according to the manual.  
Please refer to Appendix 3.2 and 3.3 for a way of the error confirmation. 

 

5) Writing completed 
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REMARK 

 

Refer to the project of parameters and positioning data to be used in the Simple Motion Module 

(LD77MH).  

In addition, if you wish to use sample data , please contact your nearest Mitsubishi sales 

representative. 

 

1) Sample data. 

Item Project name Descriptions Remark

L02_LD77MH4_POS for L02CPU and LD77MH4 

L26_LD77MH4_POS for L26CPU and LD77MH4 

Sample data of the simple 

motion 

L02_LD77MH4_SYNC for L02CPU and LD77MH4 

L26_LD77MH4_SYNC for L26CPU and LD77MH4 

Sample data for 

synchronous control of 

the simple motion 

4-axis 

type 

L02-LD77MH16_POS for L02CPU and LD77MH16

L26-LD77MH16_POS for L26CPU and LD77MH16

Sample data of the 

simple motion 

L02-LD77MH16_SYNC for L02CPU and LD77MH16

LD77MH  

sample 

data 

L26-LD77MH16_SYNC for L26CPU and LD77MH16

Sample data for 

synchronous control of 

the simple motion 

16-axis 

type 

 

2) Unpacking the download module 
Unpack the download module into any folder. 

 
3) Reading a project 

Read the project from the unpacked sample data 
(a) Select [Project] → [Open Project] from the menu. 
(b) Click the [Browse] button to select the folder in which the project is saved. 
(c) Select a project. 
(d) Click the [Open] button to open the project. 

 

 

4) Reading the project completed 
The projects provided on MELFANSweb contains the explained contents in this section "(4) Setting the 
system setting" to "(7) Positioning data setting". 

(a) 

(b) 

(c) 

(d) 
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2.9 Operation Check 

. This sequence program is an example using LD77MH4 and L26CPU-BT. When other modules are 
used, the assignment of the signal is different. Please refer to the user's manual (positioning control) for 
details of each signal. 

 

(1) JOG operation (for checking the rotation direction, the electronic gear setting etc.) 
1) Change the [RESET/RUN/STOP] switch of the PLC CPU module to RUN. 
2) Turn the Servo ON device from the sequence program. 

Select [Online] → [Monitor] → [Start Monitoring] in GX Works2 to display a monitor screen. 
Move the cursor to the PLC READY ON signal (X7B). 
Double-click the PLC READY ON signal (X7B) with pressing the SHIFT key to turn X7B ON. 

 

 

Point  

• To turn the device ON, double-click the specified device that is OFF with pressing the SHIFT 
key. To turn the device OFF, Double-click the device that is ON the SHIFT key turns. 

 
3) JOG speed setting 

Double-click JOG operation speed setting (X5D) with pressing the SHIFT key. 

 

4) JOG starting 
Double-click Forward rotation JOG (X5E) with pressing the SHIFT key to turn X5E ON and the axis 1 
rotates forward. 
Furthermore, double-click Forward rotation JOG (X5E) with pressing the SHIFT key to turn X5E OFF 
and the axis 1 stops. 

Double-click with pressing the SHIFT 

key. 

Next page 
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5) Checking JOG operation 

Double-click the [Intelligent Function Module] → [Monitor] → [Module Monitor] → [Axis Monitor]button 
 to display the axis monitor initial window. 

  

 

 

 

 
Click [Select Monitor Axis] to display a Axis Monitor screen. 
Select the displayed axis. 
Click [Select Monitor Item] to display a Axis Monitor screen. 
Select the displayed item. 
 
 
 

Select Monitor Axis : Axis #1 

  

Select Monitor Item 

Forward JOG start, Reverse JOG start 

Status : OPR request flag 

 Status : OPR complete flag 

 Start complete 

External input signal : Lower limit 

External input signal : upper limit 

  

 

1 2

1 2
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Axis Monitor 

Screen Check Item Value 
 

 
Axis 1 Current feed value  

Axis 1 Machine feed value 
  
 
Axis operation status 

Axis feed rate 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Forward JOG start 

Reverse JOG start 

 

 
- 
- 
  
 
JOG Operation 
100.00 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
ON 
OFF 
 
 
 

 

   
PLC READY 
LD77 READY 

Synchronization flag 

All axes servo ON 
Servo status : READY ON 
 Axis 1 
Servo status : Servo ON 
 Axis 1 

BUSY 

 Axis 1 

 

 
ON 

ON 

ON 

ON 
 

ON 
 

ON 
 

ON 
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[Operation check procedure] 

Item Operation Status 

All axis servo ON Turn X7B ON. 

Check servo amplifier LED. 
Check the signal state of LD77 READY X30, 
Synchronization flag, PLC READY and All axis 
servo. 

Axis 1 JOG speed 
setting Turn X5D ON. Check the JOG speed at the axis 1 current feed 

speed. 
Axis 1 forward rotation 
command turns ON Turn X5E ON. Check if the servomotor rotates forward. 

Check if the axis 1 current feed value increases. 
Axis 1 forward rotation 
command turns OFF Turn X5E OFF. Check if the servomotor stops. 

Axis 1 reverse rotation 
command turns ON Turn X5F ON. Check if the servomotor rotates reversely. 

Check if the axis 1 current feed value decreases. 
Axis 1 reverse rotation 
command turns OFF Turn X5F OFF. Check if the servomotor stops. 

 
6) Change of motor rotation direction 

Change the motor rotation direction to forward/reverse. 

 

 

Point  

• Select either "CCW direction when the forward pulse is input, CW direction when the reverse 

pulse is input" or "CW direction when the forward pulse is input, CCW direction when the 

reverse pulse is input". 

 

 

 

 

 

 

 

 
7) Completion of the JOG operation check 

CW direction when the forward pulse is input 

CCW direction when the reverse pulse is input 

CCW direction when the forward pulse is input 

CW direction when the reverse pulse is input 
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(2) OPR (for checking a home position) 
OPR ( Original Point Return) control includes "machine OPR" that establishes a machine OP without using 

address data, and "fast OPR" that carries out positioning to the coordinates established by the machine 

OPR. 

This document explains the method to operate the data setting type of machine OPR. 
 
1) To operate machine OPR 

After setting the positioning start number, turn ON the positioning start to start OPR. 

Buffer memory 
Item 

LD77MH4 LD77MH16
Signal Description 

Axis 1 positioning start No. 1500 4300 - 
Set the positioning start No. 

Set 9001 for machine OPR. 

Axis 1 positioning start - - Y40 
Execute the positioning start and 

OPR. 

 
2) Setting the axis 1 positioning start No. 

Double-click Machine OPR command (X53) with pressing the SHIFT key to turn X53 ON and to set 9001 

to the start No. register. 

 

 
3) Axis 1 OPR start 

Double-click Positioning start command (X71) with pressing the SHIFT key to turn X71 ON. 

OPR starts by setting 9001 of the start No. register to the buffer memory and turning the axis 1 

positioning start signal ON. 

 

 

Double-click with pressing the 
SHIFT key. 

Double-click with pressing the 
SHIFT key. 

Next page 
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3) Checking of axis 1 OPR 

 

Screen Check item Value 
 
 
Axis 1 Current feed value 
Axis 1 Machine feed value 
  
 
Axis operation status 
Axis feedrate 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Status: OPR request flag 

Status: OPR complete flag 

 
 

0.0 

0.0 
  
 

Waiting 
0.00 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

OFF 
ON 

 

  
  
PLC READY 
LD77 READY 

Synchronization flag 

All axes servo ON 
 
Servo status : READY ON 

 Axis 1 

Servo status : Servo ON 

 Axis 1 

 

 

 
 

ON 

ON 

ON 

ON 
 
 

ON 

 

ON 

 

 
4) Completion of axis 1 OPR 
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(3) Positioning control 
This section explains the operation check method of positioning control which uses the address 

information. 

[Operation example of returning the original position after moving to P1] 

 

 

 

 

 

 

 

 

 

 

 

 
1) To execute positioning 

After setting the positioning start number, turn ON the positioning start to start positioning. 

Buffer memory 
Item 

LD77MH4 LD77MH16
Signal Description 

Axis 1 positioning start No. 1500 4300 - Set the positioning start No. 

Axis 1 positioning start - - Y40 Execute the positioning start. 

 
2) Setting the axis 1 positioning start No. 

Double-click Positioning start command (X55) with pressing the SHIFT key to turn X55 ON and to set 1 

to the start No. register. 

 
3) Axis 1 positioning start 

Double-click Positioning start command (X71) with pressing the SHIFT key to turn X71 ON. 

Positioning starts by setting 1 of the start No. register to the buffer memory and turning the axis 1 

positioning start signal ON. 

 

 

Double-click with pressing 
the SHIFT key. 

Next page 

2000.00 
<Speed [mm/min> 

-30000.00 

P1=100.0mm 

P0=0.0mm 

<Position [mm/min]> 

Time 

Time 
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4) Checking of axis 1 positioning control 

Check if the axis 1 current feed value moves to 100.00 mm and returns to 0.0 mm. 

Check if the axis 1 feedrate is the command speed. 

Screen Check item Value 
 

 
Axis 1 Current feed value 
Axis 1 Machine feed value 
  
 
Axis operation status 
Axis federate 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
External input signal : Lower limit 
External input signal : upper limit 

 
 
－ 

－ 
  
 

Position Control
- 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
ON 
ON 

 

 
  
PLC READY 

LD77 READY 

Synchronization flag 

All axes servo ON 

Servo status : READY ON 
 Axis 1 
  
Servo status : Servo ON 
 Axis 1 
 

BUSY 

 Axis 1 

 

Error detection 

 

Axis warning detection 

 

 

ON 

ON 

ON 

ON 

 
ON 

 
 

ON 

 

 

ON 
 
 
 

none 
 

none 

(4) Completion of operation check 
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3. SYNCHRONOUS CONTROL START-UP 
This section explains the synchronous control. 

In particular, the operation check of the synchronous control parameter, positioning data for synchronous 

control and synchronous control are explained. For existing parameters and servo parameters, refer to 

Chapter 2. 

 

<Running cutoff device> 

This is a device that makes the cutter axis (axis 1) follow the operating conveyor axis (axis 2) without 

stopping and cuts the center of a work. After cutting, the cutter axis moves to the standby position. 

Synchronous control where an electronic cam is used in the cutter axis is executed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

<Specifications> 
As the roller of the belt conveyer rotates once, a work on the belt conveyor moves for one work size.  

(1) Specifications of cutter axis (cam control axis) 
Ball screw lead (PB) : 10mm 

Gear ratio of external reduction gear : 1/2 

Cam stroke : 100.0000mm 

(2) Specifications of belt conveyor 
Roller diameter : 50mm(Circumference of roller 50mm × = 157079.6µm) 

Gear ratio of external reduction gear : 1/1 (roller directly connected to a servomotor) 
 

<Operation pattern of device> 
The cutter axis (axis 1) moves constant distance in synchronization with the belt conveyor. 

After synchronization, the axis returns to the original position. 

The belt conveyor operates at constant speed. 
 

 

 

 

 

 
 

 

 

Work 

Axis 1 

Axis 2

Belt conveyor axis 

Work Work 

Cutter axis (cam control axis)

2000.00

<Speed [mm/min> 

2000.00 

Belt conveyor axis 

Cutter axis 

Time 

Time 

Roller 

<Speed [mm/min> 
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3.1 2-axes System where Synchronous Control is Available 

The following shows the configuration example of a system which combines LD77MH4, MR-J3- B and a 

servomotor. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

Motor power 
supply cable 

No-fuse 
breaker 
(NFB) 

～ 

CP

  

L61P 

SSCNET III 
Cable 

L26CPU-BT

LD77MH4 

Personal 
computer 

 
USB cable 

 

 

MR-J3-B 

Servo motor 

Encoder 
cable 

Magnetic 
contactor 

(MC)

To 1) 

 From 1)No-fuse breaker 
(NFB) 
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3.2 Start-up Procedure in Synchronous Control 

 

3.1 2-axes system where synchronous control 

is available 

 

  

Preparing devices Refer to 2.2 Preparing devices. 

  

Installing modules Refer to 2.4 Installing modules. 

  

Wiring and connecting cables Refer to 2.5 Wiring and connecting cables 

  

Installing application software Refer to 2.6 Installing application software 

  

Creating sequence programs for 

synchronous control 

(1) Creating a new project 

(2) Creating sequence programs 

(3) Saving a sequence programs as a project 

(4) Connecting CPU module and personal computer 

(5) Format the CPU module 

(6) Writing the sequence program to the PLC CPU 

  

3.3 Creating parameter for synchronous control (1) Setting the system setting 

(2) Parameter and servo parameter settings 

(3) Positioning data setting 

(4) Synchronous control parameter setting 

(5) Cam data setting 

(6) Saving a project 

(7) Writing to the Simple Motion Module 

  

3.4 Operation check (1) OPR (for establishing a home position) 

(2) Start-up of drive axis 

(3) Operation check of a synchronous axis 

(4) Operation check with digital oscilloscope 
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3.3 Creating Parameter for Synchronous Control 

 

(1) Setting the system setting 
Set the system configuration of 2-axes system. 

 

 

 

 

(2) Parameter and servo parameter settings 
Set parameters and servo parameters of the axis 1 and 2. 

The setting list is given in Appendix 2. 

The electronic gear settings of the belt conveyor are described as follows. 

[Input] 

Machine components : Conveyor 

Unit Setting : 0:mm 

Diameter of Roll  : 50000.0 [µm]

Reduction Gear Ratio (NL/NM) 

Load Side [NL] : 1 

Motor Side [NM] : 1 

Encoder resolution : 262144 

 

[Calculation result] 

Unit Setting: 0:mm 

Number of Pulses per Revolution:  

4625519PLS 

Moving Amount per Rotation:  

2771663.0µm

Unit Magnification: 1: × 1 time 
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(3) Positioning data setting 
Create a program where the belt conveyor (axis 2) moves to P1 from the home position. 

Create a cam data in synchronization with the belt conveyor for the axis 1 which executes the cam control. 

 

[Example of positioning data moving to P1 from home position] 

  

 

  

  

 

 

 

 

 

 

 
 
 
 
 

 

 

 

 
1) Selecting the positioning data 

Double-click [Intelligent Function Module] → [LD77MH4] → [Positioning Data] → [Positioning Data Axis 

#2 ] to display the positioning data screen. 

 

 
<Axis 2 Positioning data> 

No. 
Operation 

pattern 

Control 

system 

Axis to be 

interpolated 

Acceleration 

time No. 

Deceleration 

time No. 

Positioning 

address 

Arc 

address 

Command 

speed 

Dwell 

time

M 

code

1 
0: 

Completion 

INC 

Liner 1 
- 1: 1000 1: 1000 

157079.6 

µm 

0.0 

µm 

2000.00 

mm/min 
0ms 0 

100.0mm 

0.0mm 

Position of cutter axis (axis 1) 

Position of belt conveyor (axis 2) 

0.0mm 

If the roller whose diameter is 50 mm 

rotates one time, the belt conveyor 

moves for 157.0796 mm. 

Execute the cam control for following 

the movement of the belt conveyor. 

Time

Time

157.0796mm 

<Speed [mm/min> 

2000.00 

Time
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(4) Synchronous control parameter setting 
Set a parameter of the axis 1 that executes cam operation in synchronization with the current feed value of 

the axis 2 servo input axis. 

Item Description 

Input axis parameter 
Set the servo input axis type for the main axis. 

("1: Current feed value" for the axis 2) 

Synchronous parameter axis 1 Set the synchronous control parameter of the axis 1. 

 
1) Synchronous control parameter screen start-up 

Double-click [Intelligent Function Module] → [LD77MH4] → [Synchronous Control Parameter] → 

[Synchronous Control Parameter Axis 1]. 

 

2) Synchronous control parameter setting 

Click the setting area of [Main Input Axis No.] to display the contents that can be set. 

Select [1: Servo input axis]. 
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In the same way, change the underlined part. 

<Synchronous parameter axis 1> 

Item Description 

Type 1: Servo input axis 
Main input axis No. 

Axis No. 2 

Type 0: Invalid 
Main shaft 

Sub input axis No. 
Axis No. 0 

Main 1: Input+ Main shaft 

composition 

gear 
Sub 

0: Not input 

Numerator 1 
Main shaft  gear 

Denominator 1 

ON control mode 
0:No Clutch (Direct Coupled 

Operation) 

OFF control mode 0:OFF Control Invalid 
Main shaft clutch 

control setting 
High speed input request 

signal 

0 

Main shaft clutch reference address setting 
0:Current Value after Main Shaft 

Composite Gear 

Main shaft clutch ON address 0 PLS 

Travel value before main shaft clutch ON 0 PLS 

Main shaft clutch OFF address 0 PLS 

Travel value before main shaft clutch OFF 0 PLS 

Main shaft clutch smoothing system 0:Direct 

Main shaft clutch smoothing time constant 0 ms 

Slippage at main shaft clutch ON 0 PLS 

Main shaft clutch 

Slippage at main shaft clutch OFF 0 PLS 

Type 0:Invalid 
Auxiliary shaft 

Axis No. 0 

Main shaft 1:Input+ Auxiliary shaft 
composite gear Auxiliary shaft 0:No Input 

Numerator 1 Auxiliary shaft 

gear Denominator 1 

ON control mode 
0:No Clutch (Direct Coupled 

Operation) 

OFF control mode 0:OFF Control Invalid 

Auxiliary shaft 

clutch control 

setting High speed input 

request signal 

0 

Auxiliary shaft clutch reference address setting 
0:Current Value after Main Shaft 

Composite Gear 

Auxiliary shaft clutch ON address 0 PLS 

Travel value before auxiliary shaft clutch ON 0 PLS 

Auxiliary shaft clutch OFF address 0 PLS 

Travel value before auxiliary shaft clutch OFF 0 PLS 

Auxiliary shaft clutch smoothing system 0:Direct 

Auxiliary shaft clutch smoothing time constant 0 ms 

Slippage at auxiliary shaft clutch ON 0 PLS 

Auxiliary shaft 

clutch 

Slippage at auxiliary shaft clutch OFF 0 PLS 

Next page 
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Item Description 

Speed change gear arrangement 0: No transmission 

Speed change gear smoothing time constant 0ms 

Numerator 1 

Speed change 

gear 
Speed change ratio 

Denominator 1 

Unit setting selection 0: Use units of Main Input axis 

Unit 0mm 
Cam axis cycle unit 

number of decimal 

places 
0 

Cam axis length per cycle  157.0796mm 

Cam stroke amount 100000.0µm 

Cam No. 1 

Cam axis phase correction advance time 0µs 

Cam axis phase correction time constant 10ms 

Output axis 

Output axis smoothing time constant 0ms 

Setting method 0:Previous Value Current value per cycle 

after main shaft gear Initial setting value 0 PLS 

Setting method 0:Previous Value Current value per cycle 
after auxiliary shaft 
gear Initial setting value 0 PLS 

Cam axis position recovery target 
0:Cam Axis Current Value per 
Cycle Recovery 

Setting method 2:Current Feed Value 
Cam reference position

Initial setting value 0.0µm 

Setting method 0:Previous Value 

Synchronous 

control initial 

position 

parameter 

Cam axis current value 
per cycle Initial setting value 0 PLS 
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3) Input axis parameter setting of synchronous control parameter 

Double-click [Intelligent Function Module] → [LD77MH4] → [Synchronous Control Parameter] → [Input 

Axis Parameter]. 

 

 

 

 

 

 

 

 

<Input axis parameter (Axis 2)> 

Item Description 

Servo input axis type 1: Current feed value

Input smoothing time constant 0ms 
Detail setting 

Phase correction advance time 0µs 

Phase correction time constant 10ms 

Servo input 

axis 

 
Rotation direction restriction 

0: Without Rotation 
Direction Restriction 

 

 
4) Setting completion of synchronous control parameter and input axis parameter 
 

 

Setting example operating axis 1 in synchronization with the current 

feed value of the axis 2 
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(5) Cam data setting 
 
1) Cam data screen start-up 

Right-click the [Cam data] button and select [Create new data] to display the creating new data screen. 

Set the cam No. and click the [OK] button. 

 

 

 

 

 

 

 
2) Cam data screen start-up 

The initial screen is displayed to create cam data. 

 

 

Next page 
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3) Creating cam data 

When the stroke and cam curve is set as      , the cam graph appears as      . 

 

 
<Cam data> 

Section 

No. 

Start point 

[degree] 

End point 

[degree] 

Stroke 

[%] 
Cam curve 

1 0.00000 2.00000 0.0500000 Constant speed 

2 2.00000 4.00000 0.5000000 Constant speed 

3 4.00000 6.00000 1.1000000 Constant speed 

4 6.00000 8.00000 1.9000000 Constant speed 

5 8.00000 113.59160 50.0000000 Constant speed 

6 113.59160 222.00000 98.1000000 Constant speed 

7 222.00000 224.00000 98.9000000 Constant speed 

8 224.00000 226.00000 99.5000000 Constant speed 

9 226.00000 228.00000 99.9000000 Constant speed 

10 228.00000 229.18320 100.0000000 Constant speed 

11 229.18320 0.00000 0.0000000 Dist. const. speed 

 

(6) Saving a project 
Refer to the previous section "Saving a Simple Motion Module as a project". 

 

(7) Writing to the Simple Motion Module 
Refer to the previous section "Writing to the Simple Motion Module". 

 

(8) Completion of Synchronous control parameter setting 
 

(b) 

(a) 

(b) (a) 
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3.4 Operation check of synchronous control 

For details of the operation check for JOG operation, OPR and positioning control, refer to Chapter 2. 

This section explains the operation check of the synchronous control. 

Following the procedure below, the axis 1 executes the cam control in synchronization with the current feed 

value of the axis 2. 

Item Device Description 

OPR command X53 Set the OPR No. 

Axis 1 positioning start X71 Turn ON the axis 1 positioning start Y40 and start OPR of the axis 1. 

Axis 2 positioning start X72 Turn ON the axis 2 positioning start Y41 and start OPR of the axis 2. 

– – Turn OFF X71 and X72 once. 
Synchronous control 
axis setting X7D Set the synchronous control axis and G36320 to 1. 

Synchronous 
positioning No. setting X56 Set positioning No. for the synchronous control. 

Axis 2 positioning start X72 Turn ON the positioning start of the axis 2 and start the synchronous control. 

 

(1) OPR (for establishing a home position) 
Execute the OPR of the axis 2. 

For details of the operation check for the OPR of the axis 1, refer to Chapter 2. 
1) Turn Machine OPR command (X53) ON. 
2) Turn Positioning start command (axis 2) (X72) ON. 

 

3) Completion of OPR 

Double-click with 

pressing the SHIFT key.

Double-click with 

pressing the SHIFT key.
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(2) Start-up of drive axis 
1) Turn ON Synchronous control axis setting (X7D), and set H1 to the buffer memory (U3¥G36320) and 

the axis 1 as the synchronous control axis. 

 
2) Checking the axis 1 BUSY signal 

Check if the axis 1 BUSY signal is turned ON when setting H1 to the buffer memory (U3¥G36320) of the 
synchronous control start. 

Screen Axis 1 Axis 2 

 

 

 

Axis 1: Synchronous Control

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

Axis 1 : BUSY 

 
 
 
 
 
 
 
 
 
 

 

 

 

 

Double-click with 

pressing the SHIFT key.

Next page 
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3) Setting the axis 2 program No. 

 
4) Starting the axis 2 program 

Turn Positioning start command (X72) ON. 

 

Double-click with 

pressing the SHIFT key.

Double-click with 

pressing the SHIFT key.
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(3) Operation check of a synchronous axis 
1) Check if the servomotors of the axis 1 and 2 operate. 

Screen Axis 1 Axis 2 
 
 
－ 
－ 
 
Synchronous Control 
- 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
ON 
ON 

 
 
－ 
－ 
 
Positioning Control 
2000.00mm/min 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
ON 
ON 

 
2) Completion of the operation check with the intelligent function module 
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(4) Operation check with digital oscilloscope (check of cam operation) 
This section explains the method for checking the cam operation with the assistant function of the digital 

oscilloscope. 
1) Starting the digital oscilloscope 

Double-click [Digital Oscilloscope]. 

 

 

2) Starting the assistant screen 

 

 
3) Selecting operation items from the assistant screen 

The digital oscilloscope can be easily set by using the assistant function. 

[Select Online/Offline] 

• Module buffering method 

• Online 

Select the above. 

  

[Select probe items] 

• To check the cam operation 

• Axis No. "1" 

Specify the above. 

 

3)

Next page 
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[Setting of sampling condition] 

Sampling rate (ms)  : 0.888 × 1 

Sampling size  : 8192 

Trigger balance (%) : 90.00 

After trigger 

  Sampling size  : 7373 

  Sampling time (ms)  : 6553.8 

4) Setting the trigger condition 
After closing the assistant screen, select [Edit] → [Trigger] to display the Initial Setting screen. 

 

 

Select the [Trigger Setting] button. 

 
Clicking the [Trigger Setting] button displays the screen to set the trigger conditions. 

Press the [Pattern] button repeatedly to 

display . 

Set the following items. 

 

Axis 1 – Cam Axis 1 Cycle Current 

Value (42812) 

  100×0.0001 mm 

Axis 1 – Cam Axis Current Feed Value 

(42816) 

  10×0.1μm 

 
Next page 
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5) Starting sampling 

Display the assistant screen again and select "4) Start sampling (R)". 

 

[Start sampling] 

Select the [Yes] button to start sampling. 

 
6) Check the cam pattern with the digital oscilloscope. 

Check if the pattern which created the cam data and the axis 1 current feed value of the digital 
oscilloscope are the same. 

 

Select [View] → [Cursor] to display the explanation and 

value of each prove. 

 

 
(5) Completion of operation checks 

Zoom 
in 
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APPENDICES 
 
Appendix 1 Start address setting 
 
(1) Start address of Simple Motion Module 

CPU modules of L series are equipped with built-in I/O and built-in CC-Link. If connecting a Simple Motion 

Module to the right side of a CPU module, the start XY address becomes the number that is added the No. 

of I/O points corresponding to the CPU module equipment. Since the number depends on CPU modules, 

refer to the following table. 

 

[Start address of Simple Motion Module] 

The start addresses are the default values. 

LD77MH4  LD77MH16 

   

 CPU 

module 
LD77MH4

 CPU 

module 
LD77MH16 

L02CPU 00 10(H) L02CPU 00 10(H) 

L26CPU-BT 00 30(H) L26CPU-BT 00 30(H) 

 

(2) Start address setting 
When newly adding a Simple Motion Module, specify the start XY addresses to both of GX Works2 and the 

Simple Motion Module Setting Tool. 
1) GX Works2 

 

 

 

 

 

 

 

 
Set the same address. 

2) Simple Motion Module Setting Tool 
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Appendix 2 Parameter and positioning data 

This section shows the parameter and the positioning data that are used in this document. 

 

(1) Parameters 
Item Axis 1 Axis 2 

Unit Setting 0: mm 0: mm 

No. of pulses per revolution 16384[PLS] 
4625519[PLS] 
(262144[PLS]) 

Movement amount per revolution 312.5[μm] 
2771663.0[μm] 
(157079.6[μm]) 

Unit magnification 1: time 1: time 

Basic 
parameter 
1 

Bias speed at start 0.00 mm/min 0.00 mm/min 
Speed limit value 30000.00[mm/min] 30000.00[mm/min] 
Acceleration time 1000[ms] 1000[ms] 

Basic 
parameter 
2 Deceleration time 1000[ms] 1000[ms] 

Backlash compensation amount 0.0[μm] 0.0[μm] 
Software stroke limit upper limit value 214748364.7[μm] 214748364.7[μm] 
Software stroke limit lower limit value -214748364.8[μm] -214748364.8[μm] 

Software stroke limit selection 
0: Apply software stroke 

limit on current feed 
value 

0: Apply software stroke 
limit on current feed 
value 

Software stroke limit valid/invalid setting 0: Valid 0: Valid 
Command in-position width 10.0[μm] 10.0[μm] 
Torque limit setting value 300[%] 300[%] 
M code ON signal output timing 0: WITH mode 0: WITH mode 

Speed switching mode 
0: Standard speed 

switching mode 
0: Standard speed 

switching mode 
Interpolation speed designation method 0: Composite speed 0: Composite speed 

Current feed value during speed control
0: Do not update current 

feed value 
0: Do not update current 

feed value 
Input signal logic selection lower limit 1: Positive logic 1: Positive logic 
Input signal logic selection upper limit 1: Positive logic 1: Positive logic 
Input signal logic selection: External 
command/switching signal 

0: Negative logic 

Input signal logic selection: Near-point 
dog signal 

0: Negative logic 0: Negative logic 

Input signal logic selection: Manual 
pulse generator input 

0: Negative logic 

Input signal logic selection 1: Input of servo amplifier 1: Input of servo amplifier

Manual pulse generator input selection 
0: A-phase/B-phase mode 

(multiplied by 4) 
0: A-phase/B-phase mode 

(multiplied by 4) 

Speed-position function selection 
0: Speed-position 

switching control (INC 
mode) 

0: Speed-position 
switching control (INC 
mode) 

Detailed 
parameter 
1 

Forced stop valid/invalid selection 1: Invalid 
Acceleration time 1 1000[ms] 1000[ms] 
Acceleration time 2 1000[ms] 1000[ms] 
Acceleration time 3 1000[ms] 1000[ms] 
Deceleration time 1 1000[ms] 1000[ms] 
Deceleration time 2 1000[ms] 1000[ms] 

Detailed 
parameter 
2 

Deceleration time 3 1000[ms] 1000[ms] 
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Item Axis 1 Axis 2 

JOG speed limit value 15000.00[mm/min] 15000.00[mm/min] 
JOG operation acceleration time selection 0:1000 0:1000 
JOG operation deceleration time selection 0:1000 0:1000 
Acceleration/deceleration process selection 0: Automatic trapezoidal 

acceleration/ 
deceleration processing 

0: Automatic trapezoidal 
acceleration/ 
deceleration processing 

S-pattern ratio 100[%] 100[%] 
Sudden stop deceleration 1000[ms] 1000[ms] 
Stop group 1 sudden stop selection 0: Normal deceleration stop 0: Normal deceleration stop 
Stop group 2 sudden stop selection 0: Normal deceleration stop 0: Normal deceleration stop 
Stop group 3 sudden stop selection 0: Normal deceleration stop 0: Normal deceleration stop 
Positioning complete signal output time 300 300 
Allowable circular interpolation error width 10.0[μm] 10.0[μm] 
External command function selection 0: External positioning start 0: External positioning start 
Speed control 10 x multiplier setting for 
degree axis 

0: Invalid 0: Invalid 

Restart allowable range when servo OFF to 
ON 

0[PLS] 0[PLS] 

Manual pulse/INC synchronous encoder input 
type selection 

0: Differential output type 

Operation setting for speed/torque control 
mode: Speed default value selection 

0: Command speed 0: Command speed 

Operation setting for speed-torque control 
mode: Condition selection at mode switching

0:Switching Conditions Valid 
at Switching Mode 

0:Switching Conditions Valid 
at Switching Mode 

Detailed 
parameter 2 

External command signal selection 0:Unused 0:Unused 
OPR method 6: Data set method 6: Data set method 
OPR direction 0: Positive direction (address 

increment direction) 
0: Positive direction (address 

increment direction) 
OP address 0.0[μm] 0.0[μm] 
OPR speed 0.01[mm/min] 0.01[mm/min] 
Creep speed 0.01[mm/min] 0.01[mm/min] 

OPR basic 
parameters 

OPR retry 0: Do not retry OPR with limit 
switch 

0: Do not retry OPR with 
limit switch 

Setting for the movement amount after 
near-point dog ON 

0.0[μm] 0.0[μm] 

OPR acceleration time selection 0: 1000 0: 1000 
OPR deceleration time selection 0: 1000 0: 1000 
OP shift amount 0.0[μm] 0.0[μm] 
OPR torque limit value 300[%] 300[%] 
Operation setting for incompletion of OPR 0: Positioning control is not 

executed. 
0: Positioning control is not 

executed. 
Speed designation during OP shift 0: OPR speed 0: OPR speed 

OPR 
detailed 
parameters 

Dwell time during OPR retry 0[ms] 0[ms] 
Optional data monitor: Data type setting 1 0: No Setting 0: No Setting 
Optional data monitor: Data type setting 2 0: No Setting 0: No Setting 
Optional data monitor: Data type setting 3 0: No Setting 0: No Setting 
Optional data monitor: Data type setting 4 0: No Setting 0: No Setting 

Expansion 
parameters 

Operation cycle setting 1: 1.77ms 

Note 1 : The Operation cycle setting and External command signal selection are used only in a parameter of 

LD77MH16. 
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(2) Positioning data 
<Axis 1 Positioning data> 

 
Operation 

pattern 
Control 
system

Axis to be 
interpo- 

lated 

Acceleration 
time No. 

Deceleration 
time No. 

Positioning 
address 

Arc 
address 

Command 
speed 

Dwell 
time

M 
code

1 
1: 

Continuation 

ABS 

linear 1 – 1: 1000 1: 1000 100000.0μm
0.0 

μm 

2000.00 

mm/min 0ms 0 

2 
0: 

Completion 

ABS 

linear 1 – 1: 1000 1: 1000 
0.0 

μm 

0.0 

μm 

30000.00 

mm/min 0ms 0 

 
<Axis 2 Positioning data> 

 
Operation 

pattern 
Control 
system

Axis to be 
interpo- 

lated 

Acceleration 
time No. 

Deceleration 
time No. 

Positioning 
address 

Arc 
address 

Command 
speed 

Dwell 
time

M 
code

1 
0: 

Completion 

INC 

liner 1 – 1: 1000 1: 1000 
157079.6 

μm 

0.0 

μm 

2000.00 

mm/min 0ms 0 
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Appendix 3 Various monitor functions 
 
Appendix 3 1 Axis monitor 

 

(1) Select Axis Monitor 
1) Double-click the [Intelligent Function Module] → [Monitor] → [Module Monitor] →  

[Axis Monitor]button to display the axis monitor initial window. 
 

  

 

 

 
2) Select Monitor Axis 

Click [Select Monitor Axis] to display a Axis Monitor screen. 
Select the displayed axis. 

 
 

LD77MH4: Axis 1 to 4 

LD77MH16: Axis 1 to 16 

 

                  

1 2 

1 
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3) Select Monitor Item 

Click [Select Monitor Item] to display a Axis Monitor screen. 
Select the displayed item. Select the monitoring item in the Selectable Item. 
 

 

 

 
(a). Selectable Item _____ Input signal, output signal, Axis Monitor Data 

buffer memory address 
Item Selectable Item 

LD77MH4 LD77MH16

M code ON X4+n － 

Error detection X8+n － 

BUSY XC+n X10+n 

Start complete X10+n － 

Input Signal 

(X) 

Positioning complete X14+n － 

Axis stop Y4+n － 

Forward JOG start Y8+2n － 

Reverse JOG start Y9+2n － 

Positioning start Y10+n Y10+n 

Output Signal 

(Y) 

Execution prohibition flag Y14+n － 

Current feed value 800+100n 2400+100n 

Machine feed value 802+100n 2402+100n 

Feedrate 804+100n 2404+100n 

Axis error No. 806+100n 2406+100n 

Axis warning No. 807+100n 2407+100n 

Valid M code 808+100n 2408+100n 

Axis operation status 809+100n 2409+100n 

Current speed 810+100n 2410+100n 

Axis federate 812+100n 2412+100n 

Positioning amount of speed-position switching control 814+100n 2414+100n 

External input signal 816+100n 2416+100n 

Axis Monitor 

Data 

Status (Note-1) 

 In speed control, Speed-position switching latch, Command in-position, 

OPR request , OPR complete , Position-speed switching latch ,  

Axis warning detection ,  Speed change 0 , M code On ,  

error detection, start complete, positioning complete 

817+100n 2417+100n 

(Note-1) : M code On , error detection, start complete and positioning complete are defined in input signal (X) of 

LD77MH. 

2 
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(b). Selectable Item _____ Axis Monitor Data (continued) 

buffer memory address 
Item Selectable Item 

LD77MH4 LD77MH16

Target value 818+100n 2418+100n 

Target speed 820+100n 2420+100n 

Movement amount after near-point dog ON 824+100n 2424+100n 

torque limit stored value/ Forward torque limit stored value 826+100n 2426+100n 

Special start data instruction : Code setting value 827+100n 2427+100n 

Special start data instruction : Parameter setting value 828+100n 2428+100n 

Start positioning data No. setting value 829+100n 2429+100n 

In speed limit flag 830+100n 2430+100n 

In speed change processing flag 831+100n 2431+100n 

special start repetition counter 832+100n 2432+100n 

Control system repetition counter 833+100n 2433+100n 

Start data pointer being executed 834+100n 2434+100n 

Positioning data No. being executed 835+100n 2435+100n 

Block No. being executed 836+100n 2436+100n 

Last executed positioning data No. 837+100n 2437+100n 

positioning data being executed : M code 839+100n 2439+100n 

positioning data being executed : Dwell time 840+100n 2440+100n 

positioning data being executed : Axis to be interpolated － 2441+100n 

positioning data being executed : Command speed 842+100n 2442+100n 

positioning data being executed : Positioning address 844+100n 2444+100n 

positioning data being executed : Arc address 846+100n 2446+100n 

OPR re-movement amount 848+100n 2448+100n 

Real current value 850+100n 2450+100n 

Deviation counter value 852+100n 2452+100n 

Motor rotation speed 854+100n 2454+100n 

Motor current value 856+100n 2456+100n 

Parameter error No 870+100n 2470+100n 

Servo status 1 

 Zero passage, Zero speed, Speed limit, PID control 
876+100n 2476+100n 

Servo status 2 

 Control mode, Servo alarm, In-position, Torque limit,  

Absolute position lost, Servo warning 

877+100n 2477+100n 

Regenerative load ratio/ Optional data monitor output 1 878+100n 2478+100n 

Effective load ratio/ Optional data monitor output 2 879+100n 2479+100n 

Peak load torque ratio/ Optional data monitor output 3 880+100n 2480+100n 

Optional data monitor output 4 － 2481+100n 

Semi/Fully closed loop status 887+100n 2487+100n 

Servo alarm 888+100n 2488+100n 

Reverse torque limit stored value 891+100n 2491+100n 

Speed during command 892+100n 2492+100n 

Torque during command 894+100n 2494+100n 

Servo status 3 

 Continuous operation to torque control 
858+100n 2458+100n 

Axis Monitor 

Data 

Control mode switching status 895+100n 2495+100n 
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(c). Selectable Item _____ Axis Control Data  

buffer memory address 
Item Selectable Item 

LD77MH4 LD77MH16

Positioning start No. 1500+100n 4300+100n 

Positioning starting point No. 1501+100n 4301+100n 

Axis error reset 1502+100n 4302+100n 

Restart command 1503+100n 4303+100n 

M code OFF request 1504+100n 4304+100n 

External command valid 1505+100n 4305+100n 

New current value 1506+100n 4306+100n 

New acceleration time value 1508+100n 4308+100n 

New deceleration time value 1510+100n 4310+100n 

Acceleration/deceleration time change during speed change, 

 enable/disable selection 
1512+100n 4312+100n 

Positioning operation speed override 1513+100n 4313+100n 

New speed value 1514+100n 4314+100n 

Speed change request 1516+100n 4316+100n 

Inching movement amount 1517+100n 4317+100n 

JOG speed 1518+100n 4318+100n 

Interrupt request during continuous operation 1520+100n 4320+100n 

OPR request flag OFF request 1521+100n 4321+100n 

Manual pulse generator 1 pulse input magnification 1522+100n 4322+100n 

Manual pulse generator enable flag 1524+100n 4324+100n 

New torque value/ forward new torque value 1525+100n 4325+100n 

Speed-position switching control movement amount change register 1526+100n 4326+100n 

Speed-position switching enable flag 1528+100n 4328+100n 

Position-speed switching control speed change register 1530+100n 4330+100n 

Position-speed switching enable flag 1532+100n 4332+100n 

Target position change value (New address) 1534+100n 4334+100n 

Target position change value (New speed) 1536+100n 4336+100n 

Target position change request flag 1538+100n 4338+100n 

Simultaneous starting axis start data No. (axis 1 start data No.) 1540+100n 4340+100n 

Simultaneous starting axis start data No. (axis 2 start data No.) 1541+100n 4341+100n 

Simultaneous starting axis start data No. (axis 3 start data No.) 1542+100n 4342+100n 

Simultaneous starting axis start data No. (axis 4 start data No.) 1543+100n 4343+100n 

Step mode 1544+100n 4344+100n 

Step valid flag 1545+100n 4345+100n 

Step start information 1546+100n 4346+100n 

Skip command 1547+100n 4347+100n 

Teaching data selection 1548+100n 4348+100n 

Teaching positioning data No. 1549+100n 4349+100n 

ABS direction in degrees 1550+100n 4350+100n 

Servo OFF command 1551+100n 4351+100n 

Torque output setting value 1552+100n 4352+100n 

Gain changing command 1559+100n 4359+100n 

Torque change function switching request 1563+100n 4363+100n 

Axis Control 

Data 

New reverse torque value 1564+100n 4364+100n 
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(d). Selectable Item _____ Axis Control Data (continued) 

buffer memory address 
Item Selectable Item 

LD77MH4 LD77MH16

Parameter write request 1554+100n 4354+100n 

Parameter No. 1555+100n 4355+100n 

Change data 1556+100n 4356+100n 

Semi/Fully closed loop switching request 1558+100n 4358+100n 

PI-PID switching request 1565+100n 4365+100n 

Device selection for speed <-->position switching 1566+100n 4366+100n 

Speed <-->position switching command 1567+100n 4367+100n 

Control mode switching request 1574+100n 4374+100n 

Control mode setting 1575+100n 4375+100n 

Command speed at speed control mode 1576+100n 4376+100n 

Acceleration time at speed control mode 1578+100n 4378+100n 

Deceleration time at speed control mode 1579+100n 4379+100n 

Command torque at torque control mode 1580+100n 4380+100n 

Torque time constant at torque control mode (Forward direction) 1581+100n 4381+100n 

Torque time constant at torque control mode (Reverse direction) 1582+100n 4382+100n 

Speed limit value at torque control mode 1584+100n 4384+100n 

Speed limit value at continuous operation to torque control 1586+100n 4386+100n 

Acceleration time at continuous operation to torque control 1588+100n 4388+100n 

Deceleration time at continuous operation to torque control 1589+100n 4389+100n 

Target torque at continuous operation to torque control 1590+100n 4390+100n 

Torque time constant at continuous operation to torque control  

( Forward direction) 
1591+100n 4391+100n 

Torque time constant at continuous operation to torque control  

( Reverse direction) 
1592+100n 4392+100n 

Control mode switching conditions 1593+100n 4393+100n 

Control mode switching conditions (parameter) 1594+100n 4394+100n 

Axis stop － 30100+10n 

Forward run JOG start － 30101+10n 

Reverse run JOG start － 30102+10n 

Axis Control 

Data 

Execution prohibition flag － 30103+10n 
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(e). Selectable Item _____ Synchronous Control Monitor 

buffer memory address 

Item Selectable Item LD77MH4 

LD77MH16 

Current value after main shaft composite gear 42800+40n 

Current value per cycle after main shaft gear 42802+40n 

Current value per cycle after auxiliary shaft gear 42804+40n 

Cam axis phase correction amount 42810+40n 

Cam axis current value per cycle 42812+40n 

Cam reference position 42814+40n 

Cam axis current feed value 42816+40n 

Execute cam No. 42818+40n 

Execute cam stroke amount 42820+40n 

Main shaft clutch ON/OFF status 42828+40n 

Main shaft clutch smoothing status 42829+40n 

Main shaft clutch slippage (cumulative) 42830+40n 

Auxiliary shaft clutch ON/OFF status 42832+40n 

Auxiliary shaft clutch smoothing status 42833+40n 

Synchronous 

Control 

Monitor 

Auxiliary shaft clutch slippage(cumulative) 42834+40n 

 

 
(f). Selectable Item _____ Synchronous Control Data 

buffer memory address 

Item Selectable Item LD77MH4 

LD77MH16 

Main shaft clutch command 44080+20n 

Main shaft clutch control invalid command 44081+20n 

Main shaft clutch force OFF command 44082+20n 

Auxiliary shaft clutch command 44083+20n 

Auxiliary shaft clutch control invalid command 44084+20n 

Auxiliary shaft clutch force OFF command 44085+20n 

Synchronous control change request 44086+20n 

Synchronous control change command 44087+20n 

Synchronous control change value 44088+20n 

Synchronous 

Control Data 

Synchronous control change reflection time 44090+20n 
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Appendix 3.2 Error history of Simple Motion Module Setting Tool 

Error codes and warning codes at debugging a Simple Motion Module can be referred. 
1) Double-click the [Intelligent Function Module] → [Monitor] → [Module Monitor] → [Axis Monitor]      

button to display the axis monitor initial window. 
 

 

 
 

 
2) Save to CSV file 

The save screen of the CSV file is displayed when clicking on a [Create CSV File]button.  

When the file name is specified, the error history is preserved. 
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Appendix 3.3 PC diagnosis of GX Works2 

Error codes and warning codes at debugging a sequence program can be referred. 
 

1) Select [Diagnostics] → [PC Diagnostics] to display the PC diagnostics screen. 
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Appendix 4 Sample program 
 

 

 CAUTION 
 

(a) This sequence program is an example using LD77MH4 and L26CPU-BT. When other modules are used, 

the assignment of the signal is different. Please refer to the user's manual (chapter of the positioning 

control) for details of each signal.  
(b) The sequence program of this appendix is used in this startup guidance. Be sure to add and verify the 

conformance with the desired system before diverting the programs of this appendix to the actual system.

 
These sequence programs were excerpted from the necessary part of MELSEC-L Type LD77MH 

Simple Motion Module User's Manual. For details, refer to the user's manual. 

 

(1) Used device list 

Classification Device No. Signal name Signal 

X30 PLC ready completion signal 

X31 Synchronization flag 

X38 Axis 1 error detection signal 

X39 Axis 2 error detection signal 

X3C Axis 1 BUSY signal 

X3D Axis 2 BUSY signal 

X40 Axis 1 start complete signal 

X41 Axis 2 start complete signal 

LD77MH 
↓ 

PLC CPU 

X50 JOG operation speed setting command 

X53 Machine OPR No. setting 

X55 Positioning No. setting 

X56 Synchronous positioning No. setting 

X5D JOG operation speed setting command 

X5E Forward rotation JOG command 

X5F Reverse rotation JOG command 

X6E Error reset command 

X6F Stop command 

X71 Axis 1 positioning start command 

X72 Axis 2 positioning start command 

X7B PLC ready ON 

Input 

X7D Synchronous control axis setting 

Input unit 
↓ 

PLC CPU 

Y30 PLC ready signal 

Y31 All-axes servo ON signal 

Y34 Axis 1 stop signal 

Y38 Axis 1 forward rotation JOG start signal 

Y39 Axis 1 reverse rotation JOG start signal 

Y40 Axis 1 positioning start signal 

Output 

Y41 Axis 2 positioning start signal 

PLC CPU 
↓ 

LD77MH 
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(2) Sequence program example 
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ＭＥＭＯ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

WARRANTY 

Please confirm the following product warranty details before using this product. 
 
1. Gratis Warranty Term and Gratis Warranty Range 

If any faults or defects (hereinafter "Failure") found to be the responsibility of Mitsubishi occurs during use of the product 
within the gratis warranty term, the product shall be repaired at no cost via the sales representative or Mitsubishi Service 
Company. 
However, if repairs are required onsite at domestic or overseas location, expenses to send an engineer will be solely at 
the customer's discretion. Mitsubishi shall not be held responsible for any re-commissioning, maintenance, or testing on-
site that involves replacement of the failed module.  
[Gratis Warranty Term] 

The gratis warranty term of the product shall be for one year after the date of purchase or delivery to a designated 
place. 
Note that after manufacture and shipment from Mitsubishi, the maximum distribution period shall be six (6) months, and 
the longest gratis warranty term after manufacturing shall be eighteen (18) months. The gratis warranty term of repair 
parts shall not exceed the gratis warranty term before repairs. 

[Gratis Warranty Range] 
(1) The range shall be limited to normal use within the usage state, usage methods and usage environment, etc., 

which follow the conditions and precautions, etc., given in the instruction manual, user's manual and caution labels 
on the product. 

(2) Even within the gratis warranty term, repairs shall be charged for in the following cases. 
1. Failure occurring from inappropriate storage or handling, carelessness or negligence by the user. Failure caused 

by the user's hardware or software design. 
2. Failure caused by unapproved modifications, etc., to the product by the user. 
3. When the Mitsubishi product is assembled into a user's device, Failure that could have been avoided if functions 

or structures, judged as necessary in the legal safety measures the user's device is subject to or as necessary 
by industry standards, had been provided. 

4. Failure that could have been avoided if consumable parts (battery, backlight, fuse, etc.) designated in the 
instruction manual have been correctly serviced or replaced. 

5. Failure caused by external irresistible forces such as fires or abnormal voltages, and Failure caused by force 
majeure such as earthquakes, lightning, wind and water damage. 

6. Failure caused by reasons unpredictable by scientific technology standards at time of shipment from Mitsubishi. 
7. Any other failure found to not be the responsibility of Mitsubishi or that admitted not to be so by the user.  

2. Onerous repair term after discontinuation of production 
(1) Mitsubishi shall accept onerous product repairs for seven (7) years after production of the product is discontinued. 

Discontinuation of production shall be notified with Mitsubishi Technical Bulletins, etc. 
(2) Product supply (including repair parts) is not available after production is discontinued.  

3. Overseas service 
Overseas, repairs shall be accepted by Mitsubishi's local overseas FA Center. Note that the repair conditions at each FA 
Center may differ.  

4. Exclusion of loss in opportunity and secondary loss from warranty liability 
Regardless of the gratis warranty term, Mitsubishi shall not be liable for compensation to damages caused by any cause 
found not to be the responsibility of Mitsubishi, loss in opportunity, lost profits incurred to the user by Failures of Mitsubishi 
products, special damages and secondary damages whether foreseeable or not, compensation for damages to products 
other than Mitsubishi products, replacement by the user, maintenance of on-site equipment, start-up test run and other 
tasks.  

5. Changes in product specifications 
The specifications given in the catalogs, manuals or technical documents are subject to change without prior notice.  



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Microsoft, Windows, Windows NT, and Windows Vista are registered trademarks of Microsoft Corporation in 
the United States and other countries. 
Pentium is a trademark of Intel Corporation in the United States and other countries. 
Ethernet is a trademark of Xerox Corporation. 
All other company names and product names used in this manual are trademarks or registered trademarks 
of their respective companies.  
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